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1. Out of the box 

1.1 What’s what… 
Before we get started, let me introduce you to the ClassPad II! 

 
The basic overview 
Front 
Touch Screen 
This is the view screen of the ClassPad. Use 
your finger or the supplied stylus to tap on the 
touch screen to input data, perform 
calculations and so on. 

Icon panel 
The icon panel contains seven permanent 
icons. These applications can be executed by 
selecting an icon with the stylus. 

Cursor Keys 
These keys work in the same manner as 
computer cursor keys. 

k key 
This key turns on and off the display of the 
soft keyboards. 
 

Stylus 
The stylus has been designed to perform 
various touch screen operations (by pressing 
the stylus against the touch screen). 

o key 
This is the delete key. This key can also be used 
to pause the processing of various operations. 
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c key 
Turns the ClassPad on and off (press K 
first to action off). 
It also clears all data in the current working 
line. This key can also be used to interrupt the 
processing of various operations. 

K key 
This key is used to access the second function 
of each key on the hard keyboard. (See Section 
1.15 for the default key assignments.) 
 

Keypad 
This is the ‘hard’ keyboard.  

E key 
The execute key. 

 
Top 
3-pin data communication port. 4-pin mini USB port. Stylus storage. 
 
Back 
Restart button 
This is not a reset button. This button restarts 
the ClassPad. No settings are changed and no 
data is lost. 

Battery compartment –four AAA batteries 
(either alkaline or rechargeable Ni-MH). 
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1.2 Straight out of the box 
When you first take your ClassPad from its box you will need to do a series of things: 
 
 Insert the four AAA batteries. Either alkaline or Ni-MH (Nickel-metal hydride) batteries. 
 

 
 

Turn the ClassPad over and see if it has turned on. If it has 
you will see the Touch Panel alignment screen. Remove the 
stylus from the rear of the ClassPad and use it to accurately 
touch (once), the centre of each of the four target crosses. 
Once touched they will grey-out. 

 

 
 

Tap Set to select the language in which you wish the 
menus to be displayed.  
 

 
 

Select the keyboard format you wish to be displayed. 
 

 
 

Select the Battery Settings. Be sure to select the correct type 
of batteries that you have loaded into the ClassPad. 
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Note: A Warning window will appear to ensure the correct 
selection. 

 
 

The ClassPad Application MENU should now be visible. 
 
 You are ready to start! 

1.3 Not straight out of the box 
If your ClassPad is not straight from the box, some of its settings may be different to the factory 
(or default) settings. This may hinder your progress if you are a first time user of the ClassPad. 
 
If you are a first-time user of the ClassPad, we suggest you reset your ClassPad before working 
through this book. Note that resetting will erase information saved on the ClassPad by previous 
users. If you do not wish to erase the information then do not carry out the steps shown below. 
Alternatively, back up the information on the ClassPad first and then reset it. See Chapter 14, 
Managing your ClassPad II, for details on how to backup your ClassPad’s saved information. 
 
Do the following to reset the ClassPad. 
 

 
 

Press the c button to turn the ClassPad on. 
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Use your finger (or stylus) to either tap the screen selector 
or scroll the screen in order to view other icons in the 
Application MENU. 
 

Launch the  application. 

 
 

Tap the ; icon.  
 

 
 

Select Variable/Program and tap Reset. 
 
Note that any eActivities and/or files/pictures in the 
Storage Memory saved on the ClassPad will not be deleted. 
They will not hamper your progress if you are a first-time 
user. 
 

 

Tap OK. 
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The ClassPad will return to the Application MENU 

 
If you are having problems using the stylus on the touch screen, or if you wear glasses, it is 
suggested you realign the touch screen.  
 
To realign the touch screen: 
 
Tap MENU then select Touch 
Panel Alignment. 
 
Use the stylus to touch the center 
of each cross on the screen.  

 

        

 
You are ready to start! 
 
Note 
If the ClassPad does not seem to be responding at any time, use a thin blunt object to gently 
press the RESET button on the back of the ClassPad to restart it. 
 

1.4 To use the stylus or not to use… 
ClassPad II is designed to be ‘finger driven’, however for ‘fine detail’ work, as in the Geometry 
application, the stylus is available and very useful. 
 
Now before we continue, let’s explain how the screen works. 
You can ‘tap’, ‘double tap’ and ‘drag’ with either your finger or the stylus. 
 
When you tap your finger or the stylus onto the screen to execute an operation, the operation is 
performed as your finger comes off the screen. It works similar to a computer mouse click. 
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1.5 Some first steps 
Excited and scared all at the same time?  
Take that cover off and let’s get started. 
 

 
 

Press the c button to turn the ClassPad on. 
 

Tap m on the icon panel to show the ClassPad Menu. 
 
 

This is your ‘desktop’. 
 
Use your finger (or stylus) to 
either tap the screen selector or 
drag/slide the screen in order to 
view other icons in the 
Application Menu. 
 
To launch an application, simply 
tap the icon. 

 

        
 

 
 

Tap the  icon to launch the Main 
application. 
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Once launched, the Main application window will be 
displayed. The screen consists of the following 
components: 
  
 

If the work area is filled with 
calculations you may want to 
clear it. 
 
To clear the work area: 
 
Tap Edit followed by Clear 
All. 
 
The Clear All dialogue box 
will appear. 
Tap OK . 
 
The calculation history will now 
be cleared from the work area. 
         

 
 

Look at the status bar (bottom of the screen). Do you see 
the words Alg, Standard, Real and Rad? If different 
words are visible, tap each word until they are as stated 
above. 
 

An almost empty screen awaits 
you. 
 
Notice that the cursor is flashing 
to the left of an empty box. This 
signifies the calculator is ready 
for you to enter a calculation. 
    

 
 

Menu bar 

Toolbar 

Work area – input 
displayed on left, 
output displayed on 
the right. 

Status bar – displays 
current mode 
settings 
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Calculate 325 ÷ 31. 

Enter 325/31 
 
To have a calculation performed and the result displayed, press 
the blue E key at the bottom right corner of the calculator. 
 
The result is shown on the right side of the screen. Not such a 
helpful result I hear you thinking! 
 
 
 
 
Note the word Standard at the bottom of the screen. Tap the 
word Standard and note it changes to Decimal. Now all 
answers will be displayed in decimal form.  

 

 
 

Press E again.  
 
Note ans will appear on the next input line. The ClassPad 
assumes you want to calculate the same result again. 
 
We now see the result of 10.48387097. 
  

 
To see the fractional form of this decimal, tap once on the output 
and notice that the entire output is selected. 
 
 
 
 
 
 
Now tap u. Now the fractional form is displayed. 
 

 
 

 
 

 
To change the mode that the ClassPad is currently operating in, you can simply tap on the mode 

name in the status bar to change it. Alternatively, tap O on the menu bar. 
 

Status Bar Mode Indicators 
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1.6 Keyboards and the Interactive menu 
Up until now, we have only utilised the hard keyboard. 
 
Where are all the ‘other’ buttons? 
 
Press the k button. 
 

There are three main soft keyboards; ), 9, and 
-. 
Tap each tab in turn to see what the keyboards offer. 
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3

3
5






  

 
Use the hard keyboard to enter the calculation. 
 
The calculation can also be entered using natural input templates 
from the ) soft keyboard.  
 
This is the preferred method and will be used throughout the 
remainder of this book.  
 

 
 

 
However, we are not limited to 
only these ‘buttons’, there are 
more options available in the 
Interactive menu (can be 
found on the Menu bar). 
 
Also, commands not found in 
here can be found in the 
(ue. 
 

        
 

 

Is 64 46 < ? 
 
The judge( function will judge the validity of an equality or 
inequality. Use the (ue soft keyboard to enter  
judge(or just type it in. 
 
Use the - soft keyboard in order to enter the inequality 
sign. 
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Find prime factors of 360? 
 
Key in the number and select it. 
 
Tap the Interactive option 
on the menu bar, tap 
Transformation, factor 
and then select factor. 

        
 

Evaluate 324log10  
 
The calculation can be entered using natural input via the 
) soft keyboard. 
 
Note: Logarithms of bases other than 10 can be computed using 
the V button. 

 
 

 

Calculate 







−−→ 2
1lim

2 xx
. 

In the  application, enter the expression 







− 2
1

x
. Then select it by 

dragging across the expression with the stylus. Then tap the Interactive menu, select 
Calculation and then lim.  
You can see that a dialogue box appears prompting you to input the required information – no 
recall of syntax required. Entering the correct inputs and tapping OK returns the result.  
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1.7 The basics about variables 
You will notice on the hard keypad the keys x y Z. 
When pressed they input an italic letter. 
 
ClassPad understands xyz to be zyx ×× , thus removing the 
need to enter multiplication signs all the time. 
 
This feature helps us to enter algebraic expressions as we see 
and write them (without multiplication signs). 
 
However, you can also input letters using the 0 soft 
keyboard. Note that when doing this, the letters are not bold. 
ClassPad understands xyz to be the name of a variable. If we 
include multiplication signs (x×y×z) the ClassPad will 
interpret the input as three variables multiplied together.  
  

 
 

We are not restricted to just x 
y and Z on the hard 
keyboard. 
The _ soft keyboard holds 
52 variables for you to use. 
 

         
 

 
 
  

  19 



 
4 

11 

1.8 Defining variables to have a numerical value 
 
Example:  h 

a) Find the hypotenuse, h. 
                θ  

b) Find the angle, θ . 
 

Using Pythagoras’ Theorem, assign the following; a = 11, o = 4, ( )22 oah += . The angle, θ  

can be found using 







= −

hyp
opp1sinθ . 

Use the variable assignment key W, to assign a numerical value to a variable (from the _ 
soft keyboard). This key can be found on the ), 9, - and r soft 
keyboards. 
 
The value of entering the calculation in this way is that the values of a and o can be changed and 
the cursor placed in the first line and E pressed all calculations below will be re-calculated. 
 

               
 
 
 
Note that variables need to be clear of defined numeric values 
before doing symbolic calculations. 
 
To be sure the variables a to z (both lower and upper case) are 
not defined as a numeric value, use the Clear All 
Variables command in the Edit menu. 
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1.8.1 All about variables 
Numbers, lists, matrices can be 
stored as a ‘name’ using variables. 
 
There are 52 single alphabet 
variables that can be found on 
the _ soft keyboard. 
         

 
However, you can make you own 
‘names’ with the 0 soft 
keyboard. 
 

         
 

 
Where are they stored? 
Variables are stored in the current working folder. 
 
Where do I find the current working folder? 
Tap Settings O, then Variable Manager. In this instance, the current working folder is 
main. You can see that there are four variables currently stored in this folder (you may have 
more or less). 
If you double tap on this folder, it will open and you can view the stored variables. 
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How do I clear a variable? 
There are four different ways to 
delete a variable. 
 
Method 1: 
 
Tap Edit then; 
 
Clear All Variables 
 
This method clears all assigned 
variables. 
 
A dialogue box will appear to 
make sure you want to clear all 
variables.         

Method 2: 
 
Tap Action, Command then; 
 
Clear_a_z 
 
Tap E. 
 
This method clears all ‘single 
letter’ variables. 
 

        

Method 3: 
 
Tap Action, Command then; 
 
DelVar (enter variable) 
 
Tap E. 
 
This method clears only the 
variables you enter to be cleared. 
 
In the example opposite, only 
matrix A has been cleared (from 
the current working folder). 
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Method 4: 
 
Tap Settings O, then 
Variable Manager. 
 
In this instance, the current 
working folder is main. You can 
see that there are four variables 
currently stored in this folder 
(you may have more or less). 
 If you double tap on this folder, 
it will open and you can view and 
delete the stored variables. 
 

        

Select the variable(s) you wish to 
delete by checking the box in 
front of the variable. 
 
Tap Edit, then Delete. 
 
A dialogue box will appear to 
make sure you want to delete the 
selected variable(s). 
 

 
 
Tap OK and the folder will be 
clear of the deleted variable(s). 
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1.9 Basic function calculations 
Evaluate 222 ++ xx  when 

4=x . 
Method 1: 
Raise the -soft keyboard. 
 
Tap d ,f and key in the 
equation and press E. 
 
Now type in f(4) and press E. 
 
(You could also use the text f on 
the 0 soft keyboard to define 
the function, but not a variable.) 
          

 
Method 2: 
 
Key in the equation and 
highlight. 
 
Tap Interactive on the 
menu bar, then tap Define. 
 
Enter the function name and 
variable/s into the Define 
dialogue box. (The 
Expression should already be 
entered.) Tap OK. 

 
Now type in f(4) and press E. 
 

         
 

1.10 Working with angles 
When working with angles, always begin by checking that the ClassPad is set to compute in the 
angle units you are working with. Look at the status bar to find out which angle the ClassPad is 
set to use. The default setting is radians. 
Note: The ClassPad utilizes r, not c , as a notation for the units of radians. 
 
It may be useful, when working with degrees (or when you require a decimal approximation and 
not an exact value), to set the ClassPad to output the approximate decimal answer. See the next 
section for details. 
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1.10.1 Output: degrees and decimal approximation 
To change the angle mode the calculator is operating in, simply 
tap on the angle unit in the status bar.  
 
Similarly, tap the word Standard in the status bar to change 
it to Decimal. 
 
Notice the status bar has changed, and the ClassPad will now 
be operating in degrees and return outputs that are decimal 
approximations (rather than exact values.) 
 

 
 

 
 

1.10.2 Degrees to degrees, minutes and seconds 
Express °65.34 in degrees, minutes, seconds. 
 
Tap T on the ) soft keyboard. 
 
Enter the angle and press E. 
 
 
 
  

 
 

1.10.3 Degrees, minutes and seconds to degrees 
Express 9334 ′° as a decimal degree value. 
 
Tap \ (dms key) on the ) soft keyboard. 
 
Enter the angle and press E. 
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1.10.4 Convert angles in degrees to radians 
Express 9334 ′° in radians. 
 
Tap \ (dms key) on the ) soft keyboard. 
 
Tap on the angle unit in the status bar to change to Radians.  
 
Enter the angle, including the degree symbol, S, and press 
E .  
 
Note 
It is in this situation that the inclusion of the degree symbol is 
critical. It tells the ClassPad your input is in degrees. Without 
this, it would assume the input is in radians as the ClassPad is set 
to radian mode.  

 

1.10.5 Convert angles in radians to degrees 

Express 
c

11
5π in degrees, minutes, seconds. 

 
Tap on the angle unit in the status bar to change to Degrees.  
 
Tap T and enter the angle, including the radian symbol, R, 
and press E. 
 
Note: 
It is in this situation that the inclusion of the radian symbol is 
critical. It tells the ClassPad your input is in radians. Without 
this, it would assume the input is in degrees as the ClassPad is 
set to degree mode. 
  

 
 
To convert from the exact value to the decimal approximation, highlight the answer and tap 
.. (Or, tap Standard on the status bar. This will change the settings to Decimal. 
Then recalculate.) 
 

1.11 Basic trigonometric calculations 
When working with angles, always begin by checking that the ClassPad is set to compute in the 
angle units you are working with. Look at the status bar to find out which angle the ClassPad is 
set to use. The default setting is radians. 
Note: The ClassPad utilizes r, not c , as a notation for the units of radians. 
 
It may be useful, when working with degrees (or when you require a decimal approximation and 
not an exact value), to set the ClassPad to output the approximate decimal answer. 
 
This section assumes you have read Section 1.10. 
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Evaluate )'4225sin( ° . 
 
Set angle mode to degrees. 
 
On the ) soft keyboard, tap S, then  \ (dms key). 
 
Enter the angle and press E. 
 

 
 

Evaluate 






 c

7
5cos π

 

 
Set angle mode to radians. 
Use the ) soft keyboard to enter the trigonometric 
function and enter the angle.  
 
Press E. 
 

  
 

Find θ in radians if 3.0sin =θ . 
 
Set angle mode to radians. 
 
Use the r soft keyboard to key in expression. 
 
Press E. 
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Find θ in degrees, minutes and seconds if 75.0cos =θ . 
 
Set angle mode to degrees. 
 
Tap T on the ) soft keyboard. 
 
Then use the r soft keyboard to key in expression. 
 
Press E. 

 
 

1.12 Basic random number generation 
The random number generator on the ClassPad can generate: 

• Non-sequential random numbers. 
• Sequential random numbers. 

The ClassPad has five ‘random’ functions: 
• rand – generates random numbers. 
• randList – generates a list of random numbers. 
• RandSeed – configures settings for random number generation (i.e. switch between non-

sequential and sequential). The ClassPad can generate nine different patterns of sequential 
random numbers – this function is also used to choose a specific pattern. 

• randBin – generates binomial random numbers based on the number of trials, n and the 
probability, p. 

• randNorm – generates a 10 digit normal random number given mean, µ and standard 
deviation, σ. 

 

rand function  
Generate random numbers between 0 and 1.  
 
Type in, or locate in the (ue, rand(. 
 
Press E. 
 
To generate more random numbers, simply press E again.  
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Generate random integers between 25 and 50 inclusive. 
 
Type in, or locate in the (ue, rand(. Enter the start and 
end values separated with a comma. 
 
Press E. 
 
To generate more random numbers using these limits, simply 
press E again. 
 

 
 

randList function 
 
Generate 20 random numbers between 0 and 1. 
 
Type in, or locate in the (ue, randList(. 
 
Enter the number of random numbers you wish to find and 
close with a bracket. 
 
Press E.  
 

 
 

 
Generate 20 random integers between 1 and 100 inclusive. 
 
Type in, or locate in the (ue, randList( 
 
Enter 20,1,100 and close with a bracket. 
 
Press E. 
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RandSeed function 
This command requires an integer between 0 and 9 for the argument. 
 
RandSeed (0) results in non-sequential random number generation. 
 
RandSeed (integer from 1 to 9) results in that particular value as the seed for sequential random 
number generation. 
 
Generate sequential random numbers using 4 as the seed value. 
 
Type in RandSeed (and a space) or locate it in the 
(ue. Enter 4, then press E. 
 
To generate random numbers - Type in/ or locate rand( in 
the (ue. Press E. 
 
To generate more random numbers, simply press E again. 
 

 
 

 
randBin function 
Example: 
It is claimed that 1 in every 10 plastic bags made by a company 
are not water tight – they leak. The bags are sold in packets of 
50 bags. 
 
If I was to buy 100 packets, how many ‘leakers’ might I expect 
in each of my 100 packets? 
 
Generate a binomial list of 100 random numbers, where p=0.1 
and n=50. 
 
Type in, or locate in the (ue, randBin(. 
  
Enter 50,0.1,100 and close with a bracket. 
Press E. 
 
Search the list. 
 

 
 
 

 
 

You can also generate this list in the  application which makes investigating the list 
simpler. 
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randNorm command 
 
Using a normal distribution with standard deviation 20, mean 
60, sample 100 values. 
 
Type in, or locate in the (ue, randNorm(. 
 
Enter 20,60,100 and close with a bracket. 
 
Press E. 
 

You can also generate this list in the  application 
which makes investigating the list simpler. 
 
 
 

 

 
 

1.13 Basic symbolic calculations 
When entering variables it is good practice to use the italic 
letters available on the hard keyboard and on the _ soft 
keyboard. See the Section 1.7 for reasons. 
 

 
 

 

        
 

To achieve answers in the same 
format as those displayed in the 
following examples, tap O and 
select Basic Format.  
 
Under the Advanced options, 
tick Descending Order.  
 
Tap Set. 
 

 
Variables that are defined with a numerical value can cause 
problems when doing symbolic calculations.  
 
To be sure the variables a to z are not defined as a numeric 
value use the Clear All Variables command in the 
Edit menu. 
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Simplify axxx ++ 23  
 
Enter the expression and press 
E. 
 

  
 

Simplify ( )
( )yx

yx
+
− 22

 

 
Key in the expression and 
highlight. 
 
Tap Interactive on the 
menu bar, 
Transformation, then tap 
simplify. 
 

 

        
 

Expand  
a. 2)( yx +  
b. 4)( yx +  

 
To save time when entering b), 
highlight the input of a), drag and 
drop it into a new working line 
and then edit the 2 to be a 4. 
 
Press E. 

        
 

Factorise 162 −x  

        
 

32 



Factorise 62 −x : 
a) over Q – the rational 

numbers  
b) over R – the real numbers 

 

        
 

Divide 15 +x  by 2−x . 
 

        
 

Find the partial fraction 

expansion of 
)6)(3(

37
−+

+
xx

x . 

 
Enter the fraction, highlight it 
and then from the 
Interactive menu and the 
Transformation sub-menu, 
select expand. 
 
Enter x as the variable and check 
Partial Fraction. 
 
Tap OK. 
         

 

Express 
yx 3

3
2
5
+  as a single 

fraction. 
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Solve ,
2
12sin =x   

 
a) for all x. 
b) for 20 << x . 

 
Enter in the equation and 
highlight. 
 
Select Interactive, 
Equation/Inequality 
then solve. 
Use the “for” operator, U, to 
key in the condition. 
(The - tab, holds the “for” 
operator.) 
 

Tap q on the icon panel to 
view the solution in widescreen. 
 

         
 

 
 

Simultaneous Equations  
 
Solve the following simultaneous 
equations: 

52
153

+=
=+−

xy
yx

 

 
Key in the function, using the 
~ template on the ) soft 
keyboard.  

 
Note: To enter a system with 
more than 2 equations, repeatedly 
tap the ~ template.  
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Solve 32
5
9

+= CF  for C. 

 
Enter in the equation and 
highlight. 
 
Select Interactive, 
Equation/Inequality 
then solve. 
 
Set the Variable (you are solving 
for) to C. 
 
Tap OK.  

        
 

 

1.14 Active windows, menus and tool bars 
The ClassPad has a large screen. It allows us to have two applications visible the same time. 

For example we can have the  application and the  application 
visible at once. You will make use of this in this section. 
 

Solve 072 <−x for x. 
 
The ClassPad can display the 
solution to this inequality 
both numerically and 
graphically. 
 
To see the solution 
graphically:  
 
Tap $ to open the graph 
application. Select the 
inequality, then “drag and 
drop” it from Main to the 
Graph window. The graph 
window will illustrate the 
values of x for which the 
inequality is true. 
 

        
 

 
We now have two windows open, one with the bold blue boundary and one not. The blue 
border indicates which is the active window. Notice that the menu bar options and the tool bar 
change depending which windows is active. The menu bar options and the icons on the tool 
bar belong to the application whose window is active. This is an important thing to remember 
as we proceed. 
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1.15 Default K key assignments 
 
Even though it may not look like it, each key on the hard keyboard has a second function. 
Press K first to access the second function of a key. The defaults seconds functions are as 
follows: 
 

= : Copy x : Cut y : Paste Z : Undo 

( : t ) : θ , : | z : B 

1 : sin( 2 : cos( 3 : tan( 4 : Q 

5 : ln( 6 : V 7 : no assignment 8 : no assignment 

9 : no assignment 0 : π . : i e : ∞ 

E : Ans ^ : 5 / : N * : no assignment 

- : no assignment + : no assignment   
 

To change the default settings for the K key; launch the  application. 
 

Tap the s icon.  
 
The Shift Key Assign 
dialogue box will appear.  
 

Tap n to select the hard key to 
which you want to assign a shift 
mode operation.  
 
Specify the operation you wish to 
assign (choose from the soft 
keyboards), tap Set then tap OK. 
 
The operation assigned to the 
hard key is displayed in the 
status bar.         
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2. How do I… in Graph & Table? 
2.1 Create a table of values 

Tap m on the icon panel. 
 

Open the  application. 
 
Tap in the working line of y1 (or 
an empty line). Define y1 to be 

53 +x . 
 
Press E to complete the 
process. Notice the box in front 
of the function is now ticked. 
 
Tap 8 on the tool bar. This 
will display the Table Input box. 
 
Enter the domain you are 
interested in as well as the steps 
within the domain to be 
displayed, and then tap OK. 
 

 
 

 
 
 

        

Select # on the tool bar . This 
will generate a table of values and 
will be displayed in a Table 
window. (Note that the menu 
bar and tool bar options change 
when the table window is 
active). 
 

        
 

 
Note: This process is a helpful guide to choosing sensible settings for the graph view window. 
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Customising your plot view 

Tap O on the menu bar, or 
Settings on the icon panel. 
 
Select Graph Format. 
 
Check settings. 
 
Tap Set. 

 

        
 

2.2 Enter & plot functions  
There are two pathways that can be taken to plot functions: 

1. via the  application. 

2. via the  application. 
 
Method 1. 

Tap m on the icon panel. 

Open the  application. 
 
Tap in the working line of y1 (or 
an empty line). Define y1 to be 

103 +x . 
Press E to complete the 
process. Notice the box in front 
of the function is now ticked.  
 
Check the view window settings 
by tapping 6 located on the 
tool bar. If necessary, change 
your window settings, and then 
tap OK. 
 
Tap $ to have a graph of the 
function appear. (Note that the 
menu bar, tool bar options and 
status bar change when the 
graph window is active). 
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Method 2 

Tap M on the icon panel. 
 
Input the function. (In this 
example, 103 += xy .) 

Press E. 
 
Insert a graph window by 
selecting $ from the tool bar. 
A graph window should appear. 
(Note that the menu bar, tool 
bar options and status bar 
change when the graph window 
is active). 
 
Highlight the entire function and 
drag it into the graph window. 
The graph of the function will 
appear in this window. 
 

        
 

2.2.1 Using the trace function 
The trace function allows you to move a cursor along a graph. The coordinates of the position 
of the cursor are displayed in the graph view window. 
 
To operate the trace function, the 
graph view window needs to be 
active, tap in this window. 
 
Tap the Analysis menu on 
the menu bar and select Trace. 
 
Alternatively, tap = on the tool 
bar. 
 
 

        
 

 
The cursor will automatically be placed at x = 0. The cursor can be moved along the graph by 
pressing the cursor key, left or right, or by tapping the left or right graph controller arrows (on 
the edges of the graph window). 
 
If multiple graphs are sketched, press the cursor key, up or down, (or tap the up or down graph 
controller arrow) to jump between graphs. 
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If you wish to move the cursor to 
a specific x-value, after 
activating the Trace function, 
press a number key to display the 
Enter Value box.  
 
Key in the value and tap OK. 
 

        
 

2.3 Finding significant points on a graph 
At times, you will be required to do the following:  

• Find x and y intercepts 
• Find stationary points (i.e. Maximum/minimum points, points of inflection) 
• Calculate an x-value given a specific y-value or vice versa. 

 
The following instruction will assume that you have already drawn a graph of the function. 
 

2.3.1 Finding the x intercept(s) 
The graph window needs to be 
active in order to use the 
appropriate tool bar. 
 
Tap the Analysis option on 
the menu bar.  
Tap G-solve, and then select 
Root.  
 

Alternatively, tap u on the tool 
bar to scroll and view other 
options. Tap Y 
 
This will locate and display the x 
intercept. Where there is more 
than one x intercept to be found, 
simply use the cursor key (left 
and right) to allow the next 
intercept to be located. 
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2.3.2 Finding y intercept(s) 
Tap the Analysis option on 
the menu bar. 
Tap G-solve, and then select 
y-Intercept.  
 
This function will locate and 
display the y intercept. 
 

        
 

2.3.3 Finding stationary point(s) 

Maximum point(s) 
Tap the Analysis option on 
the menu bar. 
Tap G-solve, and then select 
Max. 
 

Alternatively, tap u on the tool 
bar to scroll and view other 
options. Tap U. 
     

         
 

This function will locate and display the local maximum point of the function within the 
bounds of the screen. Where there is more than one maximum point to be found, simply use 
the cursor key (left and right) to allow the next maximum point to be located. 
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Minimum point(s) 
Tap the Analysis option on 
the menu bar. 
Tap G-solve, and then select 
Min. 
 

Alternatively, tap u on the tool 
bar to scroll and view other 
options. Tap I. 

        
 

This function will locate and display the minimum point of the function. Where there is more 
than one minimum point to be found, simply use the cursor key (left and right) to locate the 
next minimum point 
 

Point(s) of inflection 
Tap the Analysis option on 
the menu bar. 
Tap G-solve, and then select 
Inflection. 
 
This function will locate and 
display the point of inflection of 
the function. Where there is more 
than one point of inflection to be 
found, simply use the cursor key 
(left and right) to locate the next 
point of inflection. 
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2.3.4 To find an x-value given a specific y-value 
Tap the Analysis option on the menu bar. Tap G-solve, x-Cal/y-Cal, and then 
select x-Cal. 
 
This function will locate and display the x and y coordinates. Where there is more than one x-
value given for a specific y-value to be found, simply use the cursor key (left and right) to allow 
the next x-value to be located. 
 

               
 

2.3.5 To find a y-value given a specific x-value 
Tap the Analysis option on the menu bar. Tap G-solve, x-Cal/y-Cal, and then 
select y-Cal. 
 
This function will locate and display the y coordinates for a given x coordinate. 
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2.4 Finding the intersection point(s) of two graphs 
Tap the Analysis option on the menu bar. Tap G-solve, and then select 
Intersection.  
 
This function will locate and display the intersection point of the graphs. Where there is more 
than one intersection point to be found, simply use the cursor key (left and right) to allow the 
next intersection point to be located. 
 

               
 

Note: If three or more functions are drawn and the intersection of two is required, the ClassPad 
will flash the cursor on one function. Use the up and down cursor keys to select the functions 
you require and press E when the required function is selected. 
 

2.5 Finding the distance between two points 
This function will locate and display the distance between two specific points. 
 
Tap the Analysis option on the menu bar, tap G-solve, and then select Distance.  
 
Press a number key to display the Enter Value dialogue box. Key in the coordinates and 
tap OK. The coordinates will be displayed in the graph window and the distance calculated in the 
message box. Alternatively, you can use the stylus to tap the two points on the screen. 
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2.6 Configuring graph view window parameters 
Tap 6 located on the tool bar. 
(Or, tap O, then select View 
Window.) This feature displays 
the View Window dialogue box.  
 

   
 

If necessary, make the 
appropriate changes, depending 
on the nature of the intended 
graph. Tap OK. 
 
(Note: The menu bar, tool bar 
options and status bar change 
when the graph window is 
active).  
 

   

 
Brief explanation of View Window parameters (rectangular coordinates): 
xmin – minimum value of x-axis ymin – minimum value of y-axis 
xmax – maximum value of x-axis ymax – maximum value of y-axis 
xscale – marker spacing of x-axis yscale – marker spacing of y-axis 
xdot – value of each screen pixel 
horizontally 

ydot – value of each screen pixel vertically 

 
The x/y dot and x/y dot values will change automatically when the x/y maximum and 
minimum values are changed. 
 
 
A number of View Window 
configurations are saved in the 
memory of the ClassPad. Tap the 
Memory drop down menu when 
the view window setting input 
box is open. 
 
You can also save your own 
settings using the File drop 
down menu. 
 

        
  

 

Graph 
Editor 
Window 

Graph 
View 
Window 

Message box 
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2.7 Zooming the graph window 

 
 

The ClassPad features an extensive selection of Zoom 
commands that can be used for either a specific region of a 
graph or to enlarge and/or reduce an entire graph. 
 
 
 
 
 
 
 
 
 
 
 
 

Below is a brief explanation of some of the Zoom commands: 
Initialize 
 
This command allows you to 
quickly return to the default view 
window settings. 

        
 

Box 
Select the Box zoom option from 
the Zoom menu or tap Q, and 
then select a region of the graph 
you want enlarge with the stylus 
by dragging a rectangle on the 
screen. 
 
Once the stylus has been taken 
off the screen, the selected region 
will be enlarged to fill the entire 
graph window display. 
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Quick 
There are six of these commands:  
Quick Trig 
Quick log(x) 
Quick e^x 
Quick x^2 
Quick –x^2 
Quick Standard 
 
These quick zoom commands 
will redraw the graph using preset 
built-in View Window 
parameters. 
 

  
 

2.8 Scrolling and panning the graph view window 
Scrolling the graph view window 
Once a graph has been sketched, it can be scrolled left, right, up or down using the cursor key 
or the graph controller arrows. 
 

 
 

 
Note 
The graph controller arrows will 
only be visible if the Graph 
Format settings are set with the 
G-Controller box ticked.  
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Panning the graph view window 
To operate this function, the graph view window needs to be active. Panning is always on, so 
position your finger (or the stylus) on the graph view window, and drag the window to an 
appropriate location. Once removed, the graph will be redrawn at that particular location. 
 

2.9 Plotting functions using parameters 
Let cbxaxf +−= 2)()( , where 
a, b and c are integers.  
 
How is the function 2)( xxf =
transformed under the following 
conditions? 
 
a) a = 1, b = 0 and c varies 
b) a = 1, b varies  and c = 0 
c) a varies, b = 0 and c = 1 
 
Method: 
a. Key the following into y1: 

}2,1,0,1,2{)0(1 2 −−+−x  
Use the ) soft keyboard 
and tap  to enter the 
parameter list. 
 
b. Key the following into y2: 

0})2,1,0,1,2{(1 2 +−−−x  
 
c. Key the following into y3: 

1)0}(2,1,0,1,2{ 2 +−−− x  
 
You could also define a list as a 
variable in the Main application and 
use that variable.  
 

a)      
 

b)  c)  
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2.10 Graphing an inequality 

 
 

It is always good practice to check the Settings of the 
Graph Format before undertaking any graphing 
activities. 
 
When graphing inequalities, make sure Inequality 
Plot is set to Intersection. 

Sketch 12 +≤ xy . 
 
Method: 

Tap n next to d on the tool 
bar and select the appropriate 
type of graph. 
 
Key in the inequality and ensure 
the box is checked.  
 
Tap $ to graph the region. 
 
 

        
 

Sketch the region bounded by the 
following: 

• 12 +≤ xy  
• xy −> 3  
• 0≥x  
• 0≥y . 
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2.11 Graph functions defined in terms of other functions 
Sketch 2)( xxf = .  
Explain graphically, the outcome of the following 
transformations 

a. )(xf−  
b. 2)( +xf  
c. )(2 xf  
d. )4( −xf  

 

In the  application tap d on the 
- soft keyboard.  
Key in the function and press E. 
 
Be sure to use a text f, not a variable f.  
 

 
 

Launch the  
application. Make y1 be f(x). 
Press E after each entry. 
 

Tap $ to graph the function.  
Functions can be sketched 
simultaneously or individually, 
depending on whether the check 
box is ticked. 
 
You can also specify the graph 
line style. Simply tap the line 
style next to the function and the 
Style Settings window will 
appear. Select your desired type 
and press OK. 
 

        
 
 

Alternative method. 
Make y1 = 2x . 
 
Then define the remaining 
functions in terms of y1(x). 
 
Be sure to use a text y, not a 
variable y. 
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2.12 Draw the inverse of a function 
Sketch 2)( xxf = and its inverse. 
 
Method: 
Enter the function into y1. Press 
E. 
 
Select the Analysis option, 
tap Sketch followed by 
Inverse.  
 
The inverse of the function will 
automatically appear in the 
Graph View Window.  
 
The inverse function will also be 
displayed in the message box. 
 

        
 

Alternative method:  
Key the function into the Main 
application window. Highlight 
the function and the select 
Interactive on the menu 
bar; tap Assistant, followed 
by invert. 
 
Check the variables in the 
invert window and press OK. 
 
The function and its inverse of 
the function will appear on the 
right hand side of the screen 
(work area). 
 
This can be sketched if required, 
by opening a graph view 
window. (Tap $ on the tool 
bar.) Select each in turn and 
“drag and drop” them into the 
graph view window. 
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2.13 Restrict the domain of a function 
Sketch xy = , where 0≥x . 
 
Key in the function, using the 
“for” operator, U, on the 
- soft keyboard followed 
by the restricted domain. 
 
 

      
 

Sketch xy = , where 22 <<− x . 
 
 
 
 

      
 

 
Note that the “for”, U, can be used in conjunction with the solve command to find solutions 
to an equation on a given domain. 
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2.14 Graphing hybrid (mixed or piecewise) functions 
Sketch the graph of 









≥
<<−+
−≤+

=
0,

02,2
2,)2(

)(

2

xx
xx

xx
xf  

 
Key in the function, then the 
“with” operator, U, followed 
by the restricted domain. (This 
can be found on the - soft 
keyboard, as are the inequality 
operators.)  
 
Tap $ on the tool bar. 
 

       
       

An alternative way to plot a 
piecewise function is to use the 
} template that can be found 
on the - soft keyboard. 
 
 

        
 

2.15 Graphing reciprocal functions 
Sketch the graph of 

1)( += xxf  and the reciprocal 

function, 
)(

1
xf

. 

 
Key in the function into y1 and 
the reciprocal function into y2. 
Tap $ on the tool bar. 
 
Alternatively, the function 

1)( += xxf  could also be 
defined in the 

 application. 
Then go to the Graph & 
Table application to graph the 
defined function. 
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2.16 Graphing rational functions 
Sketch the graph of 

4
65)(

2

−
+−

=
x

xxxf  , showing axis intercepts and asymptotes. 

 
Key in the function into y1. 
Tap $ on the tool bar. 
 
Check your graph view window settings by tapping 6 located 
on the tool bar. If necessary, change your window settings, and 
then tap OK. 
 
Alternatively, you can use the Zoom commands to resize the 
graph view.  
  

 
Use the Table function to help you find any asymptotes. 
Select # on the tool bar. This will generate a table of values 
and will be displayed in a Table window. 

 
 

2.17 Graphing sum and difference functions 

Sketch the graph of
x

xy 1
+=  . 

To sketch the graph of the sum (or difference) function, the 
individual functions are sketched onto the same set of axes. 
Using the method of addition of ordinates, the sum (or 
difference) function can then also be sketched. 
 
Key in the sum (or difference) function into y1. 
y2 = x  

y3 = 
x
1
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Use the Table function to help you use the method of 
addition of ordinates. Select # on the tool bar.  
 
This will generate a table of values and will be displayed in a 
Table window. By adding the y-coordinates of y2 and y3 will 
give the y-coordinate value of the sum function, in this case y1.  
 
Graph (and view the table of) all three functions to check your 
answers.  
 

 
 

2.18 Graphing absolute value (modulus) functions 
Sketch the graph of xy 2sin2=  

on the domain [ ]π2,0 . 
 
Key in the function, using 
absolute value 4 (9 soft 
keyboard) then the “with” 
operator, U, (- soft 
keyboard and inequality 
operators) followed by the 
restricted domain.  
 

        
 

Check your graph view window 
settings by tapping 6 located 
on the tool bar. If necessary, 
change your window settings, and 
then tap OK. 
 
Alternatively, you can use the 
Zoom commands to resize the 
graph view.  
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2.19 Graphing product functions 
Sketch the graphs of 
i) xxf =)(  
ii) xxg sin)( =  
iii) )()( xgxf . 
 
Check your graph view window 
settings by tapping 6 located 
on the tool bar. If necessary, 
change your window settings, and 
then tap OK. 
 
Alternatively, you can use the 
Zoom commands to resize the 
graph view. 

        

Use the Table function to help 
you. Select # on the tool bar.  
 
This will generate a table of 
values and will be displayed in a 
Table window. By multiplying 
the y-coordinates of y1 and y2 
will give the y-coordinate value of 
the product function, in this case 
y3.  
 
Graph (and view the table of) all 
three functions to check your 
answers. 

        

2.20 Graphing composite functions 
For the functions xxf sin)( =  

and xxg =)( : 
Sketch and state the domain of   
      i) ))(( xgf  
     ii) ))(( xfg  
 
Define the functions first in the 
Main application. This way you 
can easily key in calculations 
and/or graph the functions. 
 
Use the Table function to help 
you visualise the domain. 
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Check your graph view window 
settings by tapping 6 located 
on the tool bar. If necessary, 
change your window settings, and 
then tap OK. 
 
Alternatively, you can use the 
Zoom commands to resize the 
graph view. 
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3. Statistics with the spreadsheet application 
3.1 Mean, SD (and quartiles) 
A company owns a chain of supermarkets Australia-wide. They evaluate three different types of 
advertising: 
Type 1: no advertising 
Type 2: weekly advert in the local newspaper 
Type 3: Type 2 plus a weekly letter box drop 
 
Forty-two supermarkets are chosen to take part and fourteen are randomly assigned to try out 
each type. The table below gives the gross turnover (thousands of $) for each supermarket in the 
month during which the types of advertising were used. 
 
Type 1: 232, 243, 255, 256, 263, 264, 265, 265, 270, 273, 274, 282, 282, 295. 
Type 2: 253, 255, 261, 264, 274, 275, 289, 289, 289, 292, 292, 304, 307, 310. 
Type 3: 252, 263, 271, 272, 283, 284, 290, 293, 295, 298, 299, 299, 304, 309. 
 
Complete the table below. 
 

 Type 1 Type 2 Type 3 
mean ( x )    

standard deviation (s)    
minimum 232 253  
quartile 1 256 264  
median 265 289  

quartile 3 274 292  
maximum 295 310  

 

 

 

Tap the  icon to launch the application. 
 

 

If data is already present, from the File menu choose New and 
tap OK. 
 
We will only enter the data for Type 3 in our demonstration. 
Enter each value in column A. 
 
Tap on the heading of column A to select all cells in column A. 
 
From the Calc menu choose One-Variable. 
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A second scrollable window (bottom half of screen) will appear 
and in that will be the summary statistics of the data in column 

A. With this window active, tap r on the icon panel to view 
summary statistics full screen. 
 

The sample mean is labelled �̅�.  
 

The sample standard deviation is labelled 𝑠𝑥. 
 
Scroll down to see other summary statistics. The summary 
statistics can be pasted into the spreadsheet.  
 
The spreadsheet can be saved. 
 
To do this, tap Output. 

 
 

You can then choose where to paste these into the spreadsheet. 
The defaults will locate empty cells for pasting. Tap Paste.  
All the summary statistics are pasted into the spreadsheet. 
 

 
 
You can now complete the fourth column (Type 3) in the table 
given in the question. Note you could have calculated the quartiles 
without the ClassPad in this example. 
 

 
 

From the File menu choose Save. 

 
 

Tap { to create a new folder. 
 

 
 

  

  59 



Tap in the name SSheet. I plan to save more spreadsheets into 
this folder. 
 
Tap OK.  

 
 

Now to save the file into the folder SSheet, first select SSheet by 
tapping on it and then type in the file name super. 
 
Tap Save. 
 
To open the file at a later date, simply launch the Spreadsheet 
application and from the File 
menu choose Open. 
To open the SSheet folder, 
tap the small black arrow. 
Select the file and Open. 

 
 

 
 

3.2 Mean and SD using frequency 
 
John is a candle maker and makes a certain type of candle called large scented. On each candle’s 
label he wants to display how long the candle is expected to last. To determine the expected time 
he burns a sample of 15 candles and records the number of hours each burned for (rounded to 
the nearest hour). The data is given below. 
 
Calculate the sample mean (�̅�) and the sample standard deviation (𝑠). 
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Tap the  icon to launch the application. 
 

 

If data is already present, from the File menu choose New, tap 
OK. 
 
To save time, enter the data as a frequency table. You do not 
need the headings time and freq. 
 
Note that you could enter each of the 15 values in column A and proceeded 
without a frequency column. See section 4.1. 
 
Tap on the heading of column A and drag across to the heading 
of column B to select all cells in column A and B. 
 
From the Calc menu choose One-Variable. 
 

  
  
A second scrollable window (bottom half of screen) will appear, 
and in that will be the summary statistics of the data in 

column A. With this window active, tap r on the icon panel 
to view summary statistics full screen. 
 

The sample mean is labelled �̅�. 
 

The sample standard deviation is labelled 𝑠𝑥 . 
 
Scroll down to see other summary statistics. The summary 
statistics can be pasted into the spreadsheet.  
 
The spreadsheet can be saved. 
 
To do this, tap Output. 

 
  
You can then choose where to paste these into the spreadsheet. 
The defaults will locate empty cells for pasting. Tap Paste. 
 
All the summary statistics are pasted into the spreadsheet. 
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From the File menu choose Save. 

 
 

Now to save the file into the folder SSheet, first select SSheet by 
tapping on it and then tap in the file name candle. 
 
Tap Save. 
 
 
 
To open the file at a later date, 
simply launch the Spreadsheet 
application and from the File 
menu choose Open and proceed. 
To open the SSheet folder, 
tap the small black arrow. 
Select the file and Open. 

 
 
 

 
 

3.3 Least squares regression line 
 
1948 was the first year that General Motors Holden (GMH) 
made the first Holden (aka the Humpy or 48-215 or FX). 
Prior to that GMH assembled other car brands. From 1948 
onwards, the number of non-Holden cars assembled 
declined as the number of Holden cars made increased. 
 

 

 
 

The table below shows the number of non-Holden cars (N thousands) assembled in each year 
from 1948 to 1959. In the table, year 1 represents 1948. 
 

 
year 

 

 
1 
 

 
2 

 
3 

 
4 

 
5 

 
6 

 
7 

 
8 

 
9 

 
10 

 
11 

 
12 

 
N 

 
25.2 

 
22.2 

 
23.9 

 
20.3 

 
15.4 

 
14.4 

 
19.3 

 
20.6 

 
15.1 

 
10.9 

 

 
13.8 

 
13.2 

 
a)  Using N as the independent variable, find the equation of the least squares regression 

line. 
 
b)  Determine the size of the residual for 1953 and interpret this value. 
 
c) Use the equation to predict how many non-Holden cars would have been made, if the 

trend seen above continued, in 1974. 
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Tap the  icon to launch the application. 
 

 

If data is already present, from 
the File menu choose New, tap 
OK. 
 
Enter the data as seen opposite. 
 
Tap on the heading of column A 
and drag across to the heading of 
column B to select all cells in 
column A and B. 
 

From the chart wizard (n) tap 
X to make a scatter plot. 
 

        
 

 
To calculate the equation of the least squares regression line, tap d. 
 
You can see below that the line is drawn on the scatter plot and the details of the line are given 
in a scrollable window. 

• a – slope of the least squares regression line 
• b – y-intercept of the least squares regression line 
• r – Pearson’s product-moment correlation coefficient 
• 2r – coefficient of determination. 

 
Tap Output to paste the details into the spreadsheet (tick Residuals) and then tap Paste and 
then Close. 
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So the equation required is: 𝑁 = −1.06 × 𝑦𝑒𝑎𝑟 + 24.77 
 
Cell E6 displays the residual for 1953, -3.99, so approximately 
4000 less non-Holden cars were assembled than predicted by the 
model. 
 

 
 

We can calculate the predicted number of non-Holden cars 
assembled in 1974 (year 27) in the spreadsheet. 
Click on C8 and enter 27 and press E. 
 

Then, in cell C9 enter the formula =D1 C8+D2 and press E. 
(Note that you can tap on the cells to enter them as part of a 
formula.) 
 

 
 

So the model predicts a negative number of cars (actually 6000 
were assembled).  
 
Save this spreadsheet for potential use at a later point. 

 
 

 

×

Note: 
You can now change the value in 
cell C8 (then press E) and the 
predicted value in C9 will 
automatically be recalculated. 
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3.4 Transforming to linear 
The current study design requires that you know how to use the square, log and reciprocal transformation. In this book we illustrate the log 
transformation. The other two can be carried out in an equivalent manner using the ClassPad.  
 
 
Following on from the previous section, the table below shows the number of Holden cars 
(N thousands) assembled in each year from 1950 to 1958. In the table, year 3 represents 1950. 
 

year 3 4 5 6 7 8 9 10 11 
N 20.8 25.4 32.8 44.5 54.7 63.3 70.2 95.6 111.3 

 

 
 

a)  Apply a log N transformation to linearise this scatter plot. Determine the equation of the 
least squares regression line for the linearised data. 

 
b)  Use your answer to part (a) to predict the number of Holden cars made in 1970. 
 

 

Tap the  icon to launch the application. 
 

 

If data is already present, from the File menu choose New, and 
tap OK. 
 
Enter the data as seen opposite using columns A and B.  
In cell C1 put the heading log N. 

Press k. 
In cell C2 enter the formula =log10(B2) and then press E 
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We now need to copy the formula entered in C2 and paste it into the range of cells C3:C10. 
 
To do this, select cell B2 and then tap Edit (menu bar), Fill and then Fill Range. 
 
Enter the Range to be filled. Tap OK. 
 

               
 

Alternatively, you could have used the Copy and Paste features. These exist in both the menu 
bar under Edit OR on the soft keyboards (Copy = G; Paste = H.) 
 
Now select all cells in columns A and C by tapping on the A at the top of column A and at the 
top of column C. 

From the chart wizard (n) tap X to make a scatter plot. 
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To calculate the equation of the least squares regression line, tap d. 
 
So the equation required is: log10 𝑁 = 0.09 × 𝑦𝑒𝑎𝑟 + 1.06 
 
Tap Output to paste the details (including the residuals into the spreadsheet. 
 
In cells D7, 8 and 9 we have calculated the predicted number of cars manufactured in 1970 (year 
23). About 1.4 million! Actually, about 200,000 were manufactured that year.  
     

               
 
Save your spreadsheet for use at another time. 
 

3.5 Three-median smoothing 
The following process offers a very efficient and accurate method to calculate all values associated with three-median smoothing, potentially 
saving time in the examination. However, this method does not illustrate how the process works, which some exam questions require. 
 
 
Consider the following data and the graph of P vs t. 
 

t 24 28 45 53 68 75 82 94 
P 130 155 150 280 345 398 410 500 

 

 
 

Calculate each smoothed data point for this time series if three-median smoothing is used. 
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Tap the  icon to launch the application. 
 

 

If data is already present, from the File menu choose New, tap OK. 
 
Enter the data as seen below using columns A and B. 
 
It is wise to make a scatter plot to double check you entered the data correctly. 
 
Select the data and from the Calc menu, Regression, then choose MedMed Line. 
 

              
 
The slope and the y-intercept of the three-median-fit line are 
given. 
 
Tap Output and then Paste as you have been shown in earlier 
sections. 
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In calculating the slope and intercept, the ClassPad also calculates and stores the three-median 
points used in the calculation. 
To display the values, press k and from the (ue tab locate the commands starting 
with ‘me’, specifically medx1 and so on. 
In cell C4 enter the formula =medx1 (use the INPUT button) 
 
In D4 enter =medy1 and so on to display the three-median points. 

 

               
 
 
The real value of this spreadsheet is having it built and saved 
before the exam so that you can just enter the data, fit the line 
and display the results. 
Save the spreadsheet and call it threemed. 
 
 

 
 

 

Caution 
1. Be sure not to leave any data points from the previous 

problems in columns A and B. Select the cells and from the 
Edit menu choose Cut to clear the cells. 

2. The pasted values of a and b will not update when a new fit is 
calculated, remove them before calculating the new fit. 

3. The display of the three-median points will NOT 
automatically update when a new fit is calculated. Do not Cut 
them though, rather from the File menu choose 
Recalculate to ensure the new values are displayed. 
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3.6 Moving average smoothing 
The following process offers a very efficient and accurate method to carry out all the calculations required with this process which will 
potentially save time in the exam.  
 
 
The following table displays the share prices for a given company on the first 12 days of 
February. 
 

Date (Feb.) 1 2 3 4 5 6 7 8 9 10 11 12 
Price (AUD) 2.40 2.55 2.50 2.60 2.79 2.65 2.55 2.60 2.59 2.65 2.65 2.55 

 
Find the smoothed value for February 5 using four point moving average smoothing, with 
centering. 
 
 

Tap the  icon to launch the application. 
 

 

If data is already present, from the File menu choose New, tap OK. 
 
To calculate this value we need the data point for Feb 5 and two points on either side of it, 5 in 
total. 
 
Enter the 5 data points in columns A and B as shown below. Drag the dividing lines in between 
the column headers to narrow the columns so you can see columns A to D.  
In cell C2 enter the formula =sum(B1:B4)/4 
[the range can be entered by dragging across the cells]. 
In cell C4 enter the formula =sum(B2:B5)/4. 
In cell D3 enter the formula =(C2+C4)/2. 
 

               
 
The smoothed price for Feb 5 - $2.64. Save it as fourmean. 
 
The real value in this spreadsheet is that you can now save it and have it ready for the exam question that may 
come. You can then simply type in the five values and all the other cells will update automatically.  
 
 
 
 
 
 

 

Suggestion 
You might like to make similar spreadsheets (and save them) for the calculations involved with: 
• the 3 point moving average 
• seasonal indices. 
 
They might improve accuracy and save time in the exam. 
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4. Calculus 
4.1 Limits 

Find  a)  







∞→ xx

1lim    b)  







+→ xx

1lim
0

   c)  







−→ xx

1lim
0

 

 

In the  
application key in the limit 
statement, using the limit 

template, ;, on the 9 
soft keyboard. 

 
To enter the direction of the 
limit, use the + and - operators 
available on the 0 soft 
keyboard, tap Math tab to 
view/select. (Note: you can also 
use the standard + and – 
operators.)  
 
 

        

Alternatively, the limit statement could be entered using the lim option in the Calculation 
sub-menu of Interactive . 
 
The lim dialogue box allows you to check/enter details regarding the limit statement. 
 

               

Note that the Direction input can be -1 if you want the limit approaching from the left, 1 for the right and 0 for 
both. 
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4.2 Rates of Change 
4.2.1 Average rates of change  
Calculate the average rate of 
change for 

22)( 2 ++= xxxf  on the 
intervals: 

a. x  = 3 and x  = 3.1 
b. x  = 3 and x  = 3.05 
c. x  = 3 and x  = 3.001 
d. x  = 3 and x  = 3 + h 

 
Define the function, press E. 
 
Calculations can be easily 
performed by selecting the 
previous input, dragging and 
dropping it into the next working 
line and then editing it. 
 

        

4.2.2 Instantaneous rates of change 
Calculate the instantaneous rate of change where 

22)( 2 ++= xxxf  at x = 3. 
 
To find the instantaneous rate of change, find the limit (as h 
approaches 0) of the average rate of change for the interval  
[3, 3+h]. 
Define the function, press E. 

Key in the function, using the limit feature, ;, on the 9 
soft keyboard. 
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4.3 Derivatives 
Find  

a. the derivative of 
22)( 2 ++= xxxf  

b. )2(f ′  
c. )3(−′f  

 
Define the function, press E. 
 
Key in the problem, using the 

derivative feature, ], on the 
9 soft keyboard. Use the 
“for” operator, U, followed by 
the condition. 
 

        

Alternative method:  
Key in and select the function. 
 
Tap Interactive, then 
Calculation, followed 
diff. 
 
Select Derivative at 
value. Enter variable, order 
and value into the diff dialogue 
box. Tap OK. 
 
This feature helps you to use 
syntax to solve the task. 
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Using the   application, find )2(f ′  where 22)( 2 ++= xxxf . 
 
In this example the function has 
been defined f(x) in the Main 
application 
 

Key in the function as f(x) into 
the graph editor window. Press 
E.  
 

Tap $ to graph. 
 
Tap O, then Graph Format. 
Make sure 
Derivative/Slope is 
ticked. Tap Set. 
         

With the graph view window active, tap Analysis, then Trace. 
 
Press 2. The Enter Value box will appear. Tap OK. 
 
The derivative at x=2, along with the coordinates of the function will be displayed in the graph 
window.  
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4.3.1 Sketching the derivative function 
Sketch 22)( 2 ++= xxxf  and its 
derivative )(' xf . 
 
In this example the function has 
been defined and stored as f(x). 
 
Key in the function as f(x) into 
the graph editor window. Press 
E. 
 
Key in the derivative function, 
using the derivative template, 

], on the 9 soft 
keyboard. Press E.  
 
Tap $ to graph. 
 

        
 

4.3.2 Sign of the derivative 
How do I calculate when a derivative is negative / positive / zero? 
 

Find when the derivative of 1030274 23 +−+= xxxy  is 
negative. 
 

In the  application, find an expression for 
the derivative function. 
 
Tap $ to show the graph view window. 
‘Drag and drop’ function in the graph view window. The graph 
of the function will automatically appear in this window. Adjust 
view window as required. 
 
We can now see when the derivative is less than zero. 
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Select the derivative and drag it 
to an empty input box. 
 
Set the derivative to be <, 
using the - keyboard. 
 

Select the inequality. 
 

Tap Interactive, 
 

then Equation, 
 

then solve, 
 
then OK. 

        
 

4.3.3 Tangent and normal to a curve 
Sketch 22)( 2 ++= xxxf  the 
tangent and normal at 2−=x . 
Find the equation of the tangent 
and normal. 
 
In this example the function has 
been previously defined as f(x) in 
the Main application. 
 
Key in the function into the 
graph editor window. Press 
E. Tap $ to graph. 
With the graph view window 
active, tap Analysis, then 
Sketch, followed by 
Tangent. 
 

             
 

Enter -2 and the Enter 
Value box will appear. Tap OK. 
 
Crosshairs will appear at that 
point. You must press E in 
order for the tangent to appear. 
 
The tangent at that point, along 
with the coordinates of the 
function will be displayed in the 
graph view window.  
 
 

        
 

The equation of the tangent appears in the message box. 
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To find the normal at that point, 
make the graph view window 
active, tap Analysis, then 
Sketch, followed by Normal.  
 
Enter -2 and the Enter 
Value box will appear. Tap OK. 
 
Crosshairs will appear at that 
point. You must press E for 
the normal equation to appear. 
 
The normal at that point, along 
with the coordinates of the 
function will be displayed in the 
graph view window.  
 

        
 

The equation of the normal appears in the message box. 
 

4.4 Integration 
4.4.1 Indefinite integrals 
Find the integral of 

2610)( 34 ++= xxxf . 
 
In the Main application, key in 
the calculation, using the integral 
feature, P, on the 9 soft 
keyboard. 
 
Note: Do not enter lower & upper 
terminals for indefinite integrals. 

 
  

Alternative method: 
Key in and select the function. 
 
Tap Interactive, then 
Calculation, followed by 

∫ (the integral sign). 
 
Select Indefinite 
integral. Enter the variable 
you are integrating with respect 
to into the variable box. Tap OK. 
 
The answer will appear on screen. 
 

        

When working with 
indefinite integrals, 
don’t forget you will 
need to include the 
constant of 
integration, c, when 
writing down your 
answer. 
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4.4.2 Definite integrals (without a graphical display) 

Calculate dxe
x

x

∫ +
4

1

25 . 

Key in the function, using the 
integral feature, P, on the 
9 soft keyboard. 
 
Note: Don’t forget to enter lower 
& upper limits for definite 
integrals. 
 

  
 

Alternative method: 
Key in and select the function. 
 
Tap Interactive, then 
Calculation, followed by 

∫ (the integral sign). 
 
Select Definite integral. 
Enter the variable you are 
integrating with respect to, the 
lower and upper limits into the

∫ input box. Tap OK. 
 
Note: This method will provide 
an ‘exact’ result, if possible. 
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How do I solve for an unknown in an equation involving a definite integral? 
Calculate the value of b if

771

=∫ dx
xb

. 

Launch the  
application. 
 
Use the 9 keyboard  
to enter P. 
 

You will need the _ 

keyboard to enter the b. 
 
 

Complete and select the 
equation. 
 

   
 

Tap Interactive, 
Equation/Inequality, 
then solve. 
 
Change the variable to be solved 
for to b, using the _ 
keyboard. 
 
Tap OK. 
 

        

Two solutions, in exact form are 
provided. 
 
It may be that only one of the 
solutions is suitable, depending 
on the requirements of the 
question you are answering. 
 

  

 
 
 
 

Note: 
After entering the x 
in dx, press : 
(right cursor key) to 
ensure the cursor is 
flashing alongside the 
whole integral 
expression (not just 
the dx) before 
entering the ‘=7’. 
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4.4.3 Definite integrals (with a graphical display) 

Using the  application, 

compute the value of dxe
x

x

∫ +
4

1

25

 
and display an interpretation of it. 
 
Key the function into the graph 
editor window. Press E.  
Tap $ to graph. 
 
With the graph view window 
active, tap Analysis, then  
G-Solve, Integral, 
followed by ∫dx . 
 

        

Press 1 and the Enter Value 
box will appear. Key in the lower 
and upper intervals and tap OK. 
 
The function, along with the area 
interpretation of the integral, will 
be displayed in the graph view 
window. The decimal 
approximation of the integrals 
value will be displayed at the 
bottom of the screen. 
 

        

Note that this method will return a decimal approximation for the integral. 

4.5 Area bound by a curve and the x-axis 
Find the area bound by the x-axis and the graph of the function,

21)( xxf −= . 
 

Define the function in . 
Tap $ to show the graph view window. 
‘Drag and drop’ function in the graph view window. The graph 
of the function will automatically appear in this window. 
 
Check your graph view window settings by tapping 6 located 
on the tool bar. If necessary, change your window settings, and 
then tap OK.  
 
Or, you can use the Zoom commands to resize the graph view. 
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With the graph view window 
active, tap Analysis, then G-
Solve, Integral, followed 
by ∫dxRoot. 
 
This method uses x-intercepts 
that exist is the view window. 
 
A pink cursor will flash at the 
Lower x-intercept (or use your 
cursor key to move to the correct 
lower limit). Press E. 
 
 

            
 

The pink cursor will flash waiting 
for the Upper x-intercept , use 
your cursor key to move to the 
correct upper limit). Press E. 
 
The function, along with the area 
interpretation of the integral will 
be displayed in the graph view 
window. The decimal 
approximation of the integrals 
value will be displayed at the 
bottom of the screen. 
 

        
 

The final screen shot also contains the solution to the problem using the Main application.  
This method uses the sketch to help you determine the x-intercepts. It is good practice to use 
graphs to assist in problems involving the calculation of areas under curves. 
It is solved by using the method as shown in Section 5.4.2. 
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4.6 Area between two curves 
Find the area enclosed by 21)( xxf −=  and xxg −= 1)(  for 
the interval [0, 1]. 
 
Define the functions in the Main application.  
Tap $ to show the graph view window. 
‘Drag and drop’ functions in the graph view window. The 
graphs of the functions will automatically appear in this window. 
 
Check your graph view window settings by tapping 6 located 
on the tool bar. Or, you can use the Zoom commands to resize 
the graph view. 
 

 
With the graph view window 
active, tap Analysis, then  
G-Solve, Integral, 
followed by ∫dx
Intersection. 
 
This method uses intersection 
points that exist is the view 
window. 
 
A pink cursor will flash waiting 
for the Lower intersection point 
(use your cursor key to move to 
the correct lower limit). Press 
E.         

 

The pink cursor will flash waiting 
for the Upper intersection point 
(or use your cursor key to move 
to the correct upper limit). Press 
E. 
 
The function, along with the area 
interpretation of the integral will 
be displayed in the graph view 
window. The decimal 
approximation of the integrals 
value will be displayed at the 
bottom of the screen. 
 

        
 

The final screen shot also contains the solution to the problem using the Main application.  
This method uses the sketch to help you determine which function needs to be ‘subtracted’. It is 
good practice to use graphs to assist in problems involving the calculation of areas under curves. 
It is solved by using the method as shown in Section 5.4.2. 
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4.7 Mean value of a function 
Find the mean value of the 
function 26)( xxf =  over the 
interval [0, 4]. 
 
Use the variable assignment key 
W, to assign a numerical value 
to a variable. 

  

By using this method, you can 
easily change the upper and lower 
limits and/or the function.  
Simply “highlight”, key in 
changes and press E.  
 
The final answer will appear 
without having to re-input the 
integral. 
 

        

4.8 Second derivative 

Find )(xf ′′ if xxxf 2)( 2
5

+=  
 
Key in the problem, using the 

derivative feature, }, on the 
9 soft keyboard. 
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Alternative method: 
Enter the function and highlight. 
 
Tap Interactive, then 
Calculation, followed 
diff. 
 
Select differentiation. Enter 
variable and order (2) into the 
diff box. Tap OK. 
 
The resultant screen will view as 
in the previous method. 
 

        

 
4.9 Volumes of solids of revolution 
Consider the region bounded by the x-axis and the given lines for: 

2
0;sin π

=== xandxxy . 

Find the volume of solid of revolution generated when the region is rotated about the x-axis. 
 
 
Define the function in the Main 
application.  
 
Tap $ to show the graph view 
window. 
 
‘Drag and drop’ function in the 
graph view window. The graph 
of the function will automatically 
appear in this window. 
 
With the graph view window 
active, tap Analysis, then  
G-Solve, followed by 

∫ dxxf 2)(π . 

 

        

  

84 



Key in the lower value (press 0) 
and the Enter Value box will 
appear. Key in the lower and 
upper intervals and tap OK. 
 
The function, along with the 
volume interpretation of the 
integral will be displayed in the 
graph view window. The 
decimal approximation of the 
volume will be displayed at the 
bottom of the screen. 
 

        

The final screen shot also contains the exact solution to the problem using the 

. 
It is good practice to use graphs to assist in problems involving the calculation of volumes of 
revolution.  
 

4.10 Direction field for a differential equation 
Enter the  application.  
 
Enter the DE yy 2=′ .  
 
Tap O to have a slope field 
generated.  
 

Tap r (on icon bar at base of 
screen) to have the full screen 
view. 
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Now tap r again and tap the 
IC (Initial Conditions) tab.  
 
Set some ICs and then tap the 
O again.  
 
This will plot a path through the 
slope field, starting at (0,1) in this 
case.  
 
You can also plot the graph of a 
function to test your conjecture 
about the solution to the DE. 
 

        

Tapping the 6 icon reveals the 
View Window settings and 
allows you to set at will.  
Note the Steps setting. 
 

        

 
Note that the Spreadsheet on the ClassPad has CAS capabilities and so making a spreadsheet to 
display Euler’s Method numerically and graphically is quite simple.  
 
An eActivity that does this is available from http://www.casio.edu.shriro.com.au/. 
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5. Matrices  

5.1 Inputting matrix data 
The examples below use the 6, 7 and 8 keys on the 9 soft keyboard to enter the 
matrix using natural input. 
To do this: Tap this button: 

Create a new 1-row x 2-column matrix 6 

Create a new 2-row x 1-column matrix 7 

Create a new 2-row x 2-column matrix 8 

Add a column to the currently displayed matrix 6 

Add a row to the currently displayed matrix 7 

Add both a row and column to the currently displayed matrix 8 
 

 
Define the following matrices. 









=

34
12

A
 









−

−
=

240
112

B
 

















−
−
−

=
2
2
1

C

 









−

=
21
12

D
 

 
Key in the matrix, using the 6, 
7 and 8 keys on the 
9 soft keyboard. 
 

        

5.1.1 Matrix calculations 
This subsection will use the following exercise to demonstrate matrix calculations using the 
ClassPad. It assumes you have defined matrices A to D as shown in the previous section. 
 
Given the following matrices: 









=

34
12

A
                         

















−
−
−

=
2
2
1

C

 
 









−

−
=

240
112

B
                









−

=
21
12

D
 

 
 

Calculate the following: 
a)  
b)  
c)  
d)  
e)  
f)  
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Addition 
a) DA +  

 

  

Subtraction 
b) DA −2  
 

  

Multiplication 
c) BC 
 
 
Note that using the BC from the 
0 soft key board will not 
give the result we want. B×C 
will.  
It is good practice to use the 
letters on the _ soft 
keyboard – the bold and italic 
ones that denote a variable. 
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Computing a given power of 
a matrix 
d) 2A  
 

  

Inverse Matrix 
e) 1−A  
 

  

Determinant 
f) Adet  
 
Enter A. 
 
From the menu bar, tap 
Interactive, then Matrix, 
Calculation, followed by 
det. 
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5.2 Solving simultaneous equations using matrices 
Using matrices, solve 103 =− yx  and 152 =+ yx . 
 
We can express the simultaneous equations in matrix form: 









=















 −
1

10
52
13

y
x

 

 

And so BA
y
x

×=






 −1  

 

Enter 






 −
52
13

as A and 







1

10
as B and then compute BA ×−1  

 

 

5.3 Geometric transformations using matrices 
a) Determine the transformation matrix, yxD , , for the 

combination of transformations: a dilation by a factor of 5 
parallel to the x axis followed by a dilation by a factor of 3 
parallel to the y axis. 
 

b) Find the coordinates of the transformed image of the point 
(7,9) under yxD , . 

 
Note that we know that each point ),( yx  is mapped onto its 

image ),( yx ′′ by:  
dycxy
byaxx

+=′
+=′

 

 

Therefore, in matrix form: 















=








′
′

y
x

dc
ba

y
x

 

 

 

5.4 Transition matrices (Markov chains) 
Claude has a coffee shop. He sells coffee and biscotti. He 
realises that if a person buys (and enjoys) a coffee on a particular 
day, there is a 75% probability that the person will return a buy 
coffee the next day. In addition, if a person buys biscotti one 
day then there is a 50% probability that they will purchase 
biscotti the next day. On Monday, 90% of Claude’s patrons 
bought coffee and 40% bought biscotti. 
 
a) Determine a transition matrix, T that models this situation. 
b) Determine the initial state matrix, 0S . 
c) What is the probability that a patron will purchase a coffee 

on Tuesday? 
d) What is the probability that a patron will purchase a coffee 

on Friday? 
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6. Sequences 
Various parts of the  application are shown below. 
 

 
 
 

Task Button 
Create an ordered pair # 
Create an arithmetic sequence table ) 
Create a geometric sequence table _ 
Create a progression of difference table + 
Create a Fibonacci sequence table ` 
Draw a cobweb diagram on a graph z 
Display the Sequence RUN window ` 
Specify 𝑎𝑛+1𝑎0 as the recursion type ^ 
Specify 𝑎𝑛+1𝑎1 as the recursion type & 
Specify 𝑎𝑛+2𝑎0𝑎1 as the recursion type * 
Specify 𝑎𝑛+2𝑎1𝑎2 as the recursion type ( 
Input n of a recursion expression ? 
Delete the recursion expression in the current active line w 
Display the Sequence Table Input dialogue box 8 
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6.1 Define, tabulate & plot a sequence 
Consider the sequence 

132 >+= nnnan , . 
a) Tabulate the sequence. 
b) Plot the sequence. 

 
This is an explicit relationship 
and so tap the Explicit tab. 
 

Enter the sequence using the B 
available on the tool bar. Press 
E. 
 
To create a table for the 
sequence, tap 8, to display the 
Sequence Table Input 
box. Enter the desired 
conditions. Tap OK. 
 

  
 
 
 
 

       
 

Tap #, to display the table. 
 
To plot the sequence, the table 
window must be active.  
 
Tap ! to plot. (Or, select 
Graph, then G-Plot on the 
menu bar.) 
 
(You may need to alter the View 
Window settings, tap 6, to 
gain a sensible plot.) 
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6.2 Summing of a sequence 
Consider the arithmetic series: ...392613 +++  

a) Find the sum of the first 20 terms. 
b) Find the sum of the first n terms. 
c) The sum of how many terms first exceeds 4000? 

 
We note that, a = 13, d = 13. 
Therefore, )( 11313 −+= nan . 
Open the Main application. 
Use the 9 soft keyboard to 
enter the [ template. 
 
Using the expression found in 
part (b), we can set it equal to 
4000 and solve for n. 
 
Obviously, the solution would be 
a positive number.  
 

       

Complete the equation, select the 
equation and then: 
Tap  
Interactive menu, then tap 
Equation/Inequality, 
and then solve. 
 
Be sure to enter the correct 
variable, in this case n.  
 

 
 

       

Converting to a decimal approximation (u) shows that 
25 terms would first exceed 4000. 
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6.3 Difference equations 
Consider the sequence defined by the difference equation: 

1,2 01 =+=+ ttt nn . 
a) Find the first seven terms of the sequence. 
b) Find the 25th term. 
c) Find the sum of the first 5 terms. 
d) Plot the sequence. 

 
Select the recursive tab (since this 
difference equation is a recursive 
relationship. Use the an available 
in the n,an menu. 
Press E. 
 
To tabulate the sequence, tap 
8, to display the Sequence 
Table Input box. Enter the 
desired conditions. Tap OK.  
 
 
 

 
       

Tap #, to display the table. 
 
To plot the sequence, the table 
window must be active.  
 
Tap ! to plot. (Or, select 
Graph, then G-Plot on the 
menu bar.) 
 
(You may need to alter the View 
Window settings, tap 6, to 
gain a sensible plot.) 
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7. Probability distributions 
7.1 Discrete probability distributions 
7.1.1 Finding probabilities, the mean, variance & standard deviation 
associated with discrete random variables 
As is true in most sections, there are numerous ways to complete the computations outlined in 
this section. We have chosen methods that keep the user working within the Main application. 
 

Suppose a random variable X has distribution: 
 

x 0 1 2 
p(x) 

8

2k
 8

4 3k−

 2
2 2k−

 
 
Find the value(s) of k and the values of p(x) in each case. 
 

Define the three elements in the list as a 
function p(x). 
 
Find the sum of p(x). 

 

 
 

Then set the sum equal to 1 and solve the 
resulting equation. 
 

 
 

Note: 
If the distribution is given in the form: 
 
p(x) = 5,3,1),14( =− xxkx  
 
proceed as shown opposite to find P(X>1). 
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Find the mean, variance and standard deviation of the discrete random variable with 
distribution: 

p(x) = 5,3,1,
91

)14(
=

− xxx
 

Define p(x). 
 
Compute the mean using the mean formula.  
 
Note that two ways are illustrated opposite. 

 

 
 

Store the mean value by defining a variable to have the value 
attained.  
 
Note that any letter may be used in place of  µ (mu). 
 

 
 

Compute the variance, using µ in your 
working. 
 
Finding the square root of the variance value 
returns the standard deviation. 
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Find the mean, variance and standard deviation of the discrete random variable with 
distribution: 

,.......3,2,1,
4
1)( =





= xxp

x

 
 

Define p(x). 
 
Compute the mean using the appropriate formula. 
 
Compute the variance using the appropriate formula. 
 
Note: 
The use of the symbols µ (mu) and σ (sigma) are not necessary. 
 

 
 

7.1.2 Finding probabilities, the expected value, the variance & the standard 
deviation associated with the binomial distribution 
 
Suppose a random variable X has binomial distribution with n = 10 and p = 0.4. 
Find P(X =4). 

 
Method 1: 

Launch the  
application. 
 
From the Calc menu, choose 
Distribution. 
 
Then choose the Binomial 
PD option and tap Next. 
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Enter the values for x, 
Numtrial and prob.  
 
Tap Next and the probability 
value for P(X =4) is returned. 
 
Note: 
A nice histogram of the 
distribution can be made by 
tapping the graph icon $ in 
the top left corner. 
 
The plot can be traced to 
compute any other individual 
probabilities for this distribution. 
 

        

Method 2: 
An expedient method. 
 

Enter the  
application. 
 
From the Interactive 
menu and the 
Distribution/Inv. 
Dist sub-menu, choose 
Discrete, then 
binomialPDf command. 
 
Enter the correct inputs, tap OK 
and the probability value for  
P(X =4) is returned. 
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Suppose a random variable X has binomial distribution with n = 10 and p = 0.4. 
 
Find the P(X >6). 
 
Method 1 – this method requires 
us to determine 1- P(X <6). 
 

Launch the  
application. 
 
From the Calc menu, choose 
Distribution. 
 
Then choose the Binomial 
CD option and tap Next. 
 

        

Enter the values for Lower, 
Upper, Numtrial and prob.  
 
Tap Next and the probability 
value for P(X≤6) is returned. 
 
Note: 
A nice plot of the distribution 
can be made by tapping the graph 
icon $ in the top left corner. 
 
The plot can be traced to 
compute any other cumulative 
probabilities for this distribution. 
        

Now return to the Main application and compute 1 minus the 
probability value returned.  
prob can be found in the (ue, or simply type it in. 
 
 

 
 

  99 



 
Method 2: 
An expedient method. 
 

Enter the   
application. 
 Enter 1 –  
 
From the Interactive 
menu and the 
Distribution/Inv. 
Dist sub-menu, choose 
Discrete, then 
binomialCDf command. 
 
Enter the correct inputs, tap OK 
and the probability value for  
P(X >6) is returned. 
 
 

       

 

 
Suppose a random variable X has binomial distribution with n = 10 and p = 0.4. Find the mean, 
variance and standard deviation of X. 
 

Enter the  
application. 
 
Enter the binomial formula.  
 
Highlight the input and from the 
Interactive menu, choose  
Define and define 
Bin(r,n,p). 
 

      

Now apply the correct formula for the mean of a binomial 
distribution, making use of the defined function Bin(r,n,p).  
 
Similarly for the variance and then standard deviation. 
 
Note: 
More simply, for a binomial distribution, the mean can be 
computed by calculating pn× and the variance by calculating 

)1( ppn −×× . 
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7.2 Continuous probability distributions 
7.2.1 Finding k, graphing and finding the mean and variance 
A continuous random variable, X, has distribution described by 0,)( 2 ≥= − xkexf x .  
Find k, draw the distribution and then find the mean, variance and standard deviation. 
 

Enter the  
application. 
 
Define the function f(x). 
 
We know that the total area 
under this curve is 1 (as it is a 
probability distribution). So we 
can find k as seen opposite. 
 
We could now solve for k, but in 
this case k is clearly 2. 
 

        

A quick way to graph this 
function is to tap the application 
launcher icon and select $. 
Then in Main Work Area, enter 
f(x)|k=2 and press E.  
 
Then ‘drag and drop’ the result 
into the Graph View window. 
 
Then utilise the correct formulae 
for the mean and variance of a 
continuous random variable. 
 
Note 
It is not necessary to use the 
Greek symbols (followed by the 
equal sign) in this computation. 
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7.2.2 Standard normal distribution 
Find )2Pr( <Z  using the cumulative normal distribution. 
 

Method 1: 

Enter the   application. 
 
From the Calc menu, choose 
Distribution. 
 
Then choose the Normal CD 
option and tap Next. 
 
Enter the values for Lower and 
Upper. (Check the values for 
the standard deviation and mean.) 
 
Tap Next and the probability 
value for )2Pr( <Z is returned 
(see below).  
 

        

The next screen will also give the 
option to sketch the probability 
region. 
 
Tap $ to sketch the 
probability region. 
 

  

Method 2: 
An expedient method. 
 

Enter the   
application. 
 
From the Interactive 
menu and the 
Distribution/Inv. 
Dist sub-menu, choose 
Continuous, then normCDf 
command. 
 
Enter the correct inputs, tap OK 
and the probability value for 

)2Pr( <Z is returned. 
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7.2.3 Inverse cumulative normal distribution 
How do I calculate a boundary given a proportion/probability associated with a normal 
distribution? 
 
Suppose the girls aged between 10 and 12 years old in a given country have heights that can be 
modeled approximately normally with mean 130 cm and standard deviation 2.7 cm. 
If 35% of the girls fail to meet the height requirement for an amusement park ride, find the 
minimum acceptable height of the ride. 
 

Enter the  application. 
 
From the Calc menu, choose 
Inv. Distribution. 
 
Then choose the Inverse 
Normal CD option and tap 
Next. 
 
Enter the values for the tail 
setting, probability, standard 
deviation and mean. 
 
Tap Next. 
         

The next screen will give the 
boundary value and the option to 
sketch the probability region. 
 
Tap $ to sketch the probability 
region. 
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How do I calculate unknown population parameters for a normal distribution? 
 
The weights of a certain variety of squash are normally distributed. If 5% weigh more than 30 g 
and 10% weigh less than 15 g, find the mean and standard deviation of the distribution of 
squash weights. 
 

Launch the  
application. 
 
From the Calc menu, choose 
Inv. Distribution. 
 
Then choose the Inverse 
Normal CD option and tap 
Next. 
 
Enter the values for the tail 
setting and prob. (Check 
the values for the standard 
deviation and mean.) 
 
Tap Next and the Z-score will 
be returned. 
 

        

 

Repeat this process to calcualte 
the Z-score associated with the 
second statement about the 
population. 
 

        

Launch the M application. 
 

Use the ) keyboard for the 
simulaneous equations template 
~. 
 

Use the Z-score formula to enter 
two equations in terms of µ and 
σ (obtained from the 0 
keyboard, under the symbol tab). 
 

Use u, if required to see the 
answer in decimal form. 
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Find the value of c if 9370.0)Pr( =<<− cZc . 
 
Method 1: 

Enter the   application. 
 
From the Calc menu, choose 
Inv. Distribution. 
 
Then choose the Inverse 
Normal CD option and tap 
Next. 
 
Enter the values for the tail 
setting and prob. (Check 
the values for the standard 
deviation and mean.)  
 
Tap Next and the unknown Z 
scores will be returned.  
 

        

The next screen will give the 
unknown z values and the option 
to sketch the probability region 
(this is always a very good idea). 
 
Tap $ to sketch the probability 
region. 
 

  

Method 2: 
An expedient method. 
 

Enter the  
application. 
 
From the Interactive 
menu and the 
Distribution/Inv. 
Dist sub-menu, choose 
Inverse, then invNormCDf 
command. 
 
Enter the correct inputs, tap OK. 
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7.2.4 Equating probabilities 
 
A continuous random variable, X, has distribution described by 0,05.0)( 05.0 ≥= − xexf x . 
A second continuous random variable, Y, is distributed normally with mean 22 and standard 
deviation 2. Find k such that ).()( kYPkXP <=>  
 
 
This problem requires us to solve the following equation: 

∫∫
∞−

∞

=
k

k

dyygdxxf )()(  where )(yg is the ‘normal distribution’ function. 

We can do this as follows: 
 

In the  application, 
define the functions as shown. 
Note the change of variables. 
 
normCDf can be found in the 
catalogue. 
 
Choose a sensible view window, 
tap 6. 
 
 

        

Graph and then from the 
Analysis menu and the G-
Solve sub-menu choose 
Intersection. 
 
So k = 21.2. 
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8. Financial Calculations - TVM 
Launch the  application; you will see it has an amazing array of options. 
 

 

            
 
Tap Compound Interest.  
 
You will see that the variables associated with compound 
interest (including Annuity calculations) are laid out with input 
boxes ready to be filled. 
 
If you are not sure what a variable means, tap into that working 
line and then tap Help at the bottom of the screen. 
 
 

 
 

Suppose that we wish to 
determine the size of the 
repayments on a loan of $400 000 
for which the interest rate is 6% 
p.a. compounded monthly and 
the term of the loan is for 30 
years.  
 
Enter the variables, as seen 
opposite, and then simply tap the 
variable we wish to compute; in 

this instance tap . 
 

        
 

This is the Financial 
Application Initial 
screen. It appears if you 
have not yet used the 
application or when you 
use the Clear All 
command in the Edit 
menu while using the 
application. 

To configure the settings, 
tap O and then 
Financial Format. 
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Now tap the Calc(1) menu 
and note the Amortization 
option.  
 
The appropriate values from our 
previous problem are carried over 
and now we can carry out some 
‘what if’ exercises.  
 
We can do this for any period 
within the life of the annuity. 
 

        
 

PM1 is the number of the first installment in the period being 
considered and PM2 is the number of the last installment in that 
period. 
 
Tap BAL to have the balance calculated. 
 
We can see that after the first 10 installments are paid, the 
annuity has a balance of $395927.18. 
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9. Complex Numbers 
9.1 Complex calculations 

Launch the  application. 
 
To work with complex number calculations, the ClassPad needs 
to operate in Complex mode. 
 
To change the mode the calculator is operating in, you can 
simply tap on the specific mode name in the status bar to 
change it.  
 

Alternatively, tap O (on the menu bar) then Basic 
Format. 
 
 

 
 

The Complex Submenu contains commands that can be used 
in complex number calculations. 
 
Explanation of the commands: 
arg – will output the argument of a complex number. 
cong – will output the conjugate complex number. 
re – will output the real part of a complex number. 
im – will output the imaginary part of a complex number. 
cExpand – expands a complex expression to rectangular 
form. 
compToPol – converts a complex number into its polar 
form. 
compToTrig – converts a complex number into its 
trigonometric form. 
compToRect – converts a complex number into its 
rectangular form..  

 
 

For iz 31+= , find the 
following: 

a) argument of z  over [0, π2 ]. 
b) conjugate of z . 
c) real part of z . 
d) imaginary part of z . 

 
Enter the equation by soft 
keyboard input for i. 
 
Tap Interactive, then 
Complex, followed by arg. 
 
Continue using the Complex 
Submenu to complete the 
complex calculations. 
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Note 
Conversions from Cartesian form to polar form can be made 
using the compToTrig and compToPol commands. 
And vice versa using the cExpand command. 
 

 
 

9.2 Regions in the complex plane 

Sketch the subset of the complex 
plane of { }51:: =−zzS . 
 
Firstly, tap O (on the menu 
bar) then Basic Format. 
Make sure you tick the 
Variable is Real check 
box. Then tap Set. 
 
Assign 𝑥 + 𝑖𝑦 = 𝑧. 
Enter the equation by soft 
keyboard input Math3 using 
4and i. 
 
 

        
 

Tap $ to open the graph view 
window.  
 
Highlight the answer, then drag 
and drop into the graph window. 
 
Therefore, S is the circle with 
centre (1,0) and radius length 5 
units. 
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10. Vectors 
10.1 Viewing vectors 

Enter the  application. 
 
To configure the settings, tap O and then Geometry 
Format. 
 
Tap Set once configured. 

 
 

Tap Draw, Basic Object 
and select Vector.  
 
Then tap on the Cartesian Plane 
in two different spots, the first 
for the tail of the vector and the 
second for the head.  
 
A vector appears, labeled as r in 
this case. 
 

        
 

Now tap on the selection tool, 

G and then on the vector 
itself.  
 
Next, tap the “take me around 
the corner” icon, u to reveal the 
measurement bar. 
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You can now edit the 
components and change the 
vector. 
 

        
 

Now tap on the Cartesian Plane 
in ‘free space’ to deselect the 
vector and tap on the point 
representing the vectors tail.  
 
You can then edit its co-ordinate, 
for example to (0,0). 
 
Using the Zoom to Fit 
option from the View menu 
completes the task. 
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10.2 Operating with vectors 

Enter the  
application.  
You can use 6and 7 keys 
on the 9 soft keyboard to 
enter vector quantities 
 
Enter a vector by tapping 7, 
the column matrix template.  
 
Tapping it twice will allow you to 
enter a vector with three 
dimensions. 

 
        

 
In the Interactive menu, you will see a Vector submenu 
and all of the commands it contains. 
 

 
 

Most of these uses are self-
explanatory; the following screen 
shots illustrate some of the 
functionality. 
 
Enter the vector(s) first, highlight 
and then choose 
Interactive, Vector and 
the command you require. 
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10.3 Vectors that are functions of time 
Suppose tjtir sin2cos

~~~
+=  where t is time. What path does this describe? 

 
This path can be plotted by considering this as a function in parametric form, namely: 

ty
tx

sin2
cos

=
=

 

 
 

Enter the  application.  
 
From the Type menu, tap 
ParamType. 
 
Enter the x and y components.  
 
Tap the graph icon, $. 
 
The path appears to be elliptical. 
 

 

        
 

Note that the settings for the 
values for t can be found in the 
View Window settings (scroll to 
the bottom) window. 
 
Tap 6, to access when the 
graph view window is active. 
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11. Graphing relations, circles and ellipses 
This section explains how to graph circles and ellipses when the ClassPad is operating in the 

 application.  (You can also use this application to graph parabolas, hyperbolas and 
other general conics.) 
 
 

 
 

When you open this application, the following will be displayed: 
 
Conics Editor window 
 
 
 

Conics Graph window  

 
The following describes the purpose of each button that is located on the tool bar while the 
Conics Editor window is active. 
Draw a graph ^ 

Insert a Conics Form on the Conics Editor window q 

Adjust the equation on the Conics Editor window so it fits a 
Conics Form w 

Display the View Window dialogue box to configure Graph 
window settings 6 

 
The following describes the buttons located on the tool bar while the Conics Graph window 
is active. 
Re-draw a graph  
Makes the Conics Editor window active * 

Display the View Window dialogue box to configure Graph 
window settings 6 

Activate the pan function for dragging the Graph window n 

Enlarge the part of the screen bounded by a box Q 

Configure View Window y-axis parameters and redraw the 
graph so it fills the Graph window along the y-axis R 

Display the coordinates at a particular point on a graph = 
 

 
 

Note: 
- You can only input one 

conics equation at a time in 
the Conics Editor window. 

- This application contains 
various pre-set conic 
formats making equation 
input efficient. 

- Various graph analysis tools 
can be used when the 
Conics Graph window is 
active. 
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Sketch the graph of the circle 
with centre (2, 2) and radius 1. 
 
Enter the equation by using the 
soft keyboard input or by using 
the preset conics form menu – 
tap q. 
 
If using the preset menu, select 
the form you wish to graph. Tap 
OK. 

 

        

If using the preset method, the 
selected form will be displayed in 
the Conics Editor window. The 
equation can now be completed 
by giving H, K and R numerical 
values. 
 
Once modified, tap ^ to 
graph. 
 
 

        

Note 
Various graph Analysis tools can be used when the Conics 
Graph window is active. 
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Sketch the graph of the ellipse 
with equation 
( ) ( ) 1

9
2

4
1

2

2

2

2

=
−

+
− yx

. 

 
Enter the equation by using the 
soft keyboard input or by using 
the preset conics form menu – 
tap q. 
 
If using the preset menu, select 
the form you wish to graph. Tap 
OK. 

 
        

If using the preset method, the 
selected form will be displayed in 
the Conics Editor window. The 
equation can now be modified. 
 
Tap ^ to graph. 
 
Use the Zoom menu or change 
the View Window settings, 6, 
to be able to view the conic in its 
entirety. 
 

        

Note: Various graph analysis tools can be used when the Conics 
Graph window is active. 
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12. Using the Geometry application  
How do I build it?  How do I measure it?  How do I animate it? 

12.1 Introduction 
The ClassPad is the only hand-held device to be equipped with the unique constraint-based 

 application. While you are able to make constructions in a manner similar to that 
employed by GSP or Cabri Geometre, setting constraints when forming objects is often far 
more expedient and saves a lot of construction getting in the way of the key learning point at 
hand. 
 
This section focuses on building by setting constraints. 
 

12.2 Drawing 

Launch the  
application. 
 
The Draw menu contains many 
tools for both drawing and 
construction. 
 
 Icon shortcuts exist for many of 
these options. 

 

        

Select the Line Segment 

option by tapping y. 
 
The tool is selected when it is 
highlighted blue. 
 
A line segment is defined by two 
points, so tap in two different 
places on the screen.  
 
Note that the line segment tool is 
still selected. Tap the selection 

tool G icon to activate the 
selection tool. 

        

So, we now have drawn three objects, a line segment and two points. Each object has a set of 
properties that the ClassPad can measure. 
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12.3 Measuring the properties of objects 
Tap the arrow pointing to the right at the end of the icon bar, 

u  
This takes you around the corner to the measurement bar – it will be 
mostly empty to begin with. 
 

 
 

Tap on the line segment (not one 
of the end-points, but in the 
centre of the line segment).  
 
Note that the first option is for 
the ClassPad to measure the 
length of the line segment.  
 
If you tap the small left-most 
drop down arrow you will see 
what else the ClassPad can 
measure.  
 
In order we have: length, slope, 
angle (from the positive x-axis), 
equation and the last option 
offers the chance to name the 
line. 

 

        

Tap in free-space and you will see 
that nothing is selected and so no 
measurements are shown.  
 
Now tap on a point and see what 
is measured. 
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12.4 Moving objects around 
Go around the corner, w and make 
sure the selection tool is 
highlighted. 
 
Tap in free-space.  
  
Now tap on the line segment and 
then put the stylus back on the 
line, but this time leave the tip on 
the glass and then drag the stylus 
across the glass, the line segment 
should move. 
 

        

Tap in free space and then tap on a point. 
 
Then go back and put the stylus on the point, and drag across 
the glass. Note that the point stays highlighted and so you 
should be able to go back on it and move it again. 
 
Tapping in free-space de-selects any object and allows you to re-
select from scratch. 
 

   
 

12.5 Setting a constraint 
Suppose we want to make ‘fred’ 5 
units long and have a gradient of 
zero and make these properties 
fixed.  
 
Tap in free space and then go 

around the corner, u. Highlight 
the line segment and measure its 
length. 
 
Change the length to 5 and tap 

the R (or press E). 
 

Note the T, indicating the 
constraint has been set and the 
length is fixed to be five units. 
 

        

120 



Now measure the line segments 
slope.  
 

Note the R, indicating the 
slope is changeable (not 
constrained).  
 
Now change the value to 0 and 

tap the R (or press E). 
 

The R will change to T, 
indicating the constraint has been 
set and the slope is fixed to be 
zero units. 
 

        

12.6 Drawing other objects 
Draw two other line segments to 
form a triangle.  
 
Then draw a circle within the 
bounds of the triangle. 
 

        

Now, to make this triangle an 
incircle we can use the ‘tangency’ 
property.  

Tap u to reveal the 
measurement bar. 
 Select the circle and one side 
ofthe triangle.  
Note that the tangency property 
says No. To make it say Yes and 

constrain it to be so, tap the R 

and it will change to T.  
Tap in free space, select the circle 
and one other side of the triangle 
and repeat.  
 
Repeat again for the third side 
and an incircle is created. 
 

        

Move the vertices and note the system is constrained so the 
sides of the triangle are always tangential to the circle. 
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12.7 How do I animate? 
Suppose I want to have point C 
move along a line segment.  
 
First draw the line segment.  
 
Then constrain C to the line 
segment using interest tool (select 

both objects and tap R. 
 
Then click in free-space. 
 
Any point can be made to move 
along any curve provided the 
curve has a start and end. Hence, 
an infinite line is of no use to us 
when making an animation. 
 

        

Select point C and the segment 
IJ. 
 
Then go to the Edit menu and 
the Animate sub-menu and 
choose to Add Animation.  
 
Then return to the same menu 
and choose one of the Go 
options and the animation should 
start. 
 

        

12.8 How do I display measurements? 
Three ways exist to display 
measurements.  
 
Once you have drawn an object 
you can select it and then display 

the measurement bar (tap u).  
 
Note that the ClassPad can 
measure different properties of 
an object.  
 
For a line segment, it can 
measure length, gradient, angle 
from the positive x axis, equation 
and finally you can attach text to 
the object. 
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You can take any measurement 
and drag it onto the working area.  
 
This allows you to watch the 
measurements change as you 
move or animate the structure.  
 
You can edit the default word 
‘length’ to make it what you like. 
 

        

You can also attach a measure to 
an angle. 
 
Construct a second segment CD. 
 
Select both segments and use the 
Attached Angle command.  
 
The angles measure will change 
as you change the construction 
by dragging or while animating. 
 

        

12.9 How do I do a calculation? 
You can perform a calculation 
using the measurements you have 
displayed. 
 
Be sure the measurement bar is 
visible (as opposed to all the 
drawing tools) and then use the 
Expression command from 
the Draw menu. 
 
This will result in the cursor 
flashing in the measurement bar 
waiting for input. 
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To add the two angles together, 
tap on the number that precedes 
the measure (1 and 2) in this case, 
putting a plus in between. 
Pressing E results in the 
calculation being performed.  
 
You can edit the text EXPR= to 
be whatever you like.  
 
The calculation will change in 
response to the construction 
being changed by dragging or 
animation. 
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13. Algy 2: Checker of students’ working 
 
Unlike most other mathematics software, Algy 2 does not compute and display answers to 
calculations. Algy 2 checks the logic of the user’s: 

• numeric computation, 
• symbolic computation or 
• algebraic manipulation.  

 
Algy 2 is a checker of thinking, particularly symbolic 
manipulation and exact numerical computation. The user can 
input the results of their thinking and Algy 2 will check the 
thinking and then report whether the thinking is correct or 
incorrect. 
 
The user is able to input single or multiple lines of related 
working and Algy 2 will check each line against the top line or 
each line against the previous line. The latter allowing the user to 
identify which line of working contains an error. 
 
By providing a way to check their logic, Algy 2 encourages 
thinking, perseverance and experimentation with numerical 
computation, symbolic computation and symbolic manipulation. 
 

        

 
Where do I get it? 
 
ALGY 2 will run on the Casio ClassPad and Windows equipped PCs. It can be downloaded from 
www.stepsinlogic.com  
 
It is free with every purchase of a ClassPad in Australia. Look for your voucher inside your 
ClassPad box. 
 
If you like ALGY 2 please tell us. If you do not, please tell us. Share your thoughts on the topic by 
sending an email to support@stepsinlogic.com 
 
 
  

  125 

http://www.stepsinlogic.com/
mailto:support@stepsinlogic.com


14. Managing your ClassPad II 

14.1 Touch Panel Alignment 
To ensure perfectly accurate 
tapping, the touch panel can be 
aligned easily. 
 
Tap MENU and then choose 
Touch Pad Alignment. 
 
Then use the stylus to tap in the 
centre of each of the four 
crosses. 

        

14.2 Operating System (OS) 
The ClassPad hand-held device consists of two elements, the hardware and the software. 
Regular software updates will be supplied by CASIO as improvements to the software occur. 
 
To determine the OS installed on your ClassPad, tap MENU and 
then choose Version. 
 
At the time of writing, the current OS was 
Version 01.00.0000.0000 
 

 
  

 

14.3 Updating ClassPad to latest OS 
Visit http://edu.casio.com to determine the latest OS and if necessary download the latest OS. 
 
The updating process is simple, run the update software on your computer, plug your ClassPad 
into the computer via the USB port and follow the instructions on the update software. 
 
However, please ensure that if you are using a laptop computer it is plugged into the mains 
power supply. If the laptop loses power during the update process, the ClassPad may be 
rendered unusable. 
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14.4 Types of memory 
The ClassPad has two different storage memory ‘compartments’ inside the case: 
 

1. ClassPad internal memory (5.5 MB), which holds all the data you generate on the 
ClassPad (calculations, files, ….). 

 
2. USB flash memory (24 MB), which can be thought of as a ‘USB flash drive’ and can 

store many things including regular computer files. 
 
 
 

14.5 Connecting a ClassPad to a computer (via USB) 
 
The Classpad has a mini-USB port on its top edge. A USB to 
mini-USB cable is supplied with each ClassaPad. When you plug 
it into a computer (Mac or Windows) the screen seen opposite 
will appear. A description of each option follows. 
 
1. USB Flash 
Tapping option 1 will result in the Flash memory part of your 
ClassPad mounting on your computer. You can then add files to 
it as required. More details are provided later in this chapter. 
 
2. Screen Receiver 
Computer software called Screen Receiver can be freely 
downloaded at http://edu.casio.com 
Once installed on your computer and launched, you can display 
the screen of ClassPad on your computer screen and then 
project that via a computer projector onto a big screen. 
 
Screen capture can also be performed using this software. The 
screen shot files can be saved as a picture file and/or pasted into 
worksheets and other documents. Automatic prompts along the 
way will help you with this process. 
 
3. Screen Receiver (XP) 
Use this option to connect to the Screen Receiver software if 
you are using Windows XP. 
 
4. Projector 
The ClassPad can be directly displayed by some models in the 
CASIO data projector range. 
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14.6 Backing up and restoring the ClassPad 
The data you create on the 
ClassPad may be important. So it 
is not lost if the ClassPad 
malfunctions, it is wise to 
regularly backup your ClassPad. 
 
Tap MENU and then choose 
Save As. 
 
This allows you to make a file 
containing all the data inside your 
ClassPad’s internal memory. 
 
The file extension is .vcp 
 
         

Rename the file to something 
like: 
backup04072013.vcp 
and tap Save. 
 
This file is now saved to the flash 
drive section of the ClassPad. 
For safe keeping, you should 
transfer it to a computer.  
 
Connect the ClassPad to a 
computer via the USB port, select 
the USB Flash option. 
 

        

The drive will mount on your 
computer like a normal memory 
stick and you can drag the file to 
a folder on your computer. 
 
Safely disconnect the ClassPad 
from the computer. 
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To restore the contents of a 
ClassPad to the contents of a 
backup file, make sure the 
backup file is in the flash memory 
(in this case a later backup) and 
then tap MENU and then choose 
Open. 
 
Select the file you want to restore 
from and tap Open. 
 
Choose the appropriate option 
with respect to erasing and over 
writing. 
 
Tap OK.         

 

14.7 Add-in applications 
Algy 2 is an example of an Add-in 
application. It is not installed at 
the factory, but can be installed 
later. The fx-CP 400 is able to 
accept .c2a Add-in files. 
 
Algy2_0_1_CP400.c2a can be 
retrieved from 
http://www.stepsinlogic.com 
 
To install, connect the ClassPad to 
a computer, choose USB Flash 
mode and then drag the .c2a file 
into the root directory of the flash 
memory. 
 

 
 

 
Safely disconnect the ClassPad from the computer 
and you will be able to locate the application on 
the ClassPad’s Menu and launch it for use. 
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14.8 Displaying pictures 
Pictures can be displayed on the ClassPad. 
 
The ClassPad accepts a special picture file format, namely .c2p 
 
File types like .jpg can be converted to .c2p. 

 
Once the image you want to 
display is converted, connect the 
ClassPad to a computer, choose 
USB Flash mode and then drag 
the .c2p file(s) into the folder 
named Picture on the flash 
memory. 
 
Safely disconnect the ClassPad 
from the computer. 

 
 

 
To view and work with a picture, 

launch the  application 
and make the graph window 
active by tapping in it. 
 
Tap a and then tap Open 
Picture. 
 
Select the picture you want to 
view. 
 
Proceed as desired. 
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14.9 File and data transfer 
The files and data created on the ClassPad can be transferred to another ClassPad, allowing 
people to share files. 
 
You can either: 

1. Transfer the complete contents of one ClassPad to another ClassPad. 
2. Transferring a variable (ClassPad language for a single file or other saved data) from 

one ClassPad to another Classpad. 

 

14.9.1 Complete contents transfer 
The complete contents of the ClassPad can be saved as a .vcp file. This process is identical to the 
backup process outlined in Section 14.6. 
 
The advantage of this process is that you can email the .vcp file to the person with whom you 
want to share the contents. 

14.9.2 Individual variable transfer via USB 

Launch the  and select 
Export Variables. 
 
Tap Select.  
 
Located the file or variable you 
want to transfer. In this case it is 
a spreadsheet file named cereal.  
 
Check it and then tap Export. 
 
 
 
 

        

The next window shows you the 
directories in the Flash memory 
of the ClassPad. 
 
Tap OK to save the spreadsheet 
in the form of a .xcp file with the 
same name as the spreadsheet, in 
this case cereal-(Mem).xcp, in 
the root directory of the Flash 
memory area. 
 
You can now connect your 
ClassPad to a computer, choose 
USB Flash, locate the .xcp file 
and email it to another person. 
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To import the contents of a .xcp file into a different ClassPad, first connect the ClassPad to a 
computer and choose USB Flash. Copy the .xcp file into the root directory of the flash memory 
folder. 
 
Safely disconnect the ClassPad. 
 

Launch the  application 
and check View Storage and 
Import. 
 
Tap Select.  
 
Locate the .xcp file, in this case 
named cereal-(MEM).xcp.  
 
Check it and then tap Import. 
 
Choose where you would like to 
save the file. 
 
The spreadsheet will now be 
accessible in the Classpad’s 
memory for use. 
 

         

14.9.3 Individual variable transfer via 3pin 
A second transfer port can be found on the top edge of the ClassPad. It is called the 3pin port. 
 
Individual variables can be transferred from one ClassPad to another using the 3pin cable that is 
supplied with each ClassPad. 
 

The  application is used to transfer variables using this method. 
 
From the Setup menu choose 3pin as the Cable Type on both ClassPads. 
 
Connect the ClassPads using the 3 pin cable. Ensure it ‘clicks’ when you insert it in the port. 
 
From the Link menu, set one ClassPad to Receive and the other ClassPad to Transmit. 
 
On the unit transmitting, select the items for transmission (multiple items can be selected). 
Tap OK and the transmission will take place. 
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15. Solving equations 
Equations may have none, one or more than one solutions. The solutions can be represented 
graphically and can be expressed in ‘exact form’, meaning the number is expressed as a fraction, a 
surd, in terms of pi or e or as a decimal approximation. 
 
When a computer solves an equation it can use one of two methods: 

1. Numerical iteration 
2. CAS (Computer Algebra System) algorithm 

 
Numerical iteration will result in solutions represented as decimal approximations and not all 
solutions may be found. 
 
A CAS algorithm will return all solutions in exact form – most of the time! Sometimes however, it 
may fail or give remarkably complicated results and take a long time to do it. Remember you can 
always use your mind! 
 
When solving equations using the ClassPad, it is suggested you first figure out if you 
require solutions to be given in exact form. If you do, use CAS; if you do not, then use 
numerical iteration. 

15.1 Solving equations using numerical iteration 
Solve the equation 5𝑥2𝑒−𝑥 = 2 with solutions given as decimal approximations. 

 

Launch . 
Set the modes to Alg, Standard, 
Real and Rad. 
 
Enter the equation and select it. 
 
Choose solve from the 
Interactive menu. 
Check Solve numerically. 
Choosing Solve numerically results in 
the machine using numerical iteration. 
 
Tap OK. 
Note the warning! Tap OK. 
         

Three solutions are given. 
 
It is wise to make a graphical 
representation of the solutions to 
get a sense of if anymore exist. 
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Tap $ and drag and drop each 
side of the equation into the 
graph window. 
 
From the Analysis menu, the 
Intersection command can be 
chosen. 
 
Three solutions can be seen, you 
should be able to reason why 
there are no more. 
 
 
 

         

15.2 Solving equations using CAS 
Solve the equation 4 cos2(2𝑥 − 𝜋) = 1 for −𝜋 < 𝑥 < 𝜋 giving answer in exact form. 

 
Enter the equation and select it. 
 
Choose solve from the 
Interactive menu. 
Select Solve.  
 
Choosing Solve results in the machine 
using a CAS algorithm. 
 

        

Tap OK. 
 
Eight solutions are given, in exact 
form. 
 
It is still wise to make a graphical 
representation of the solutions. 
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15.3 When CAS cannot solve an equation 
Try to solve the equation 5𝑥2𝑒−𝑥 = 2 using CAS. 

 
In this case, even though we 
‘request’ CAS to be used, the 
ClassPad realized it could not use 
CAS and switched to using 
numerical iteration. 
 
There is no analytical method 
programmed into the 
ClassPad to solve this 
equation. Can you solve it 
analytically? 
 
As a result the ‘more solution’ 
warning appears and decimal 
approximations are returned. 
               

15.4 When CAS takes some time 
Try to solve the equation 3𝑥3 − 6𝑥2 − 6𝑥 − 1 = 0 using CAS. 

 
Well it turns out that the CAS can solve this 
equation using an analytical method. But, it takes 
some time, and the solution is ‘interesting’. 
 
Watch the bottom right of screen for the 
‘spinning wheel’, it indicates the ClassPad is 
thinking hard! 
 
If it spins for too long, tap Esc on the toolbar at 
the bottom of the screen.  

It is not likely you will need this sort of solution, 
so solve such an equation using numerical 
iteration. 
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15.4 The moral of the story with equations 
It is possible you may enter an equation, try to solve it using CAS and an error message will be 
retuned, e.g. Insufficient Memory. This is not a common occurrence, but if it does happen, it is 
very unlikely you require solutions in exact form – so do not try to solve the equation using 
CAS. 
 
Each method of solving equations using a ClassPad has pros and cons. 
 
Using numerical iteration via a graph requires you to set an appropriate view window as only 
solutions that are visible will be found. 
 
Using numerical iteration via ‘Solve numerically’ may not give you all the solutions to the 
equation, and will give the solutions as decimal approximations. 
 
Using CAS via ‘Solve’ may sometimes give you interesting solutions. 
 
The moral is simple. Figure out whether or not you need solutions in exact form, if you do, use 
CAS or your mind, if you do not, use numerical iteration. 
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Appendix 1 – Statistics with the Statistics application 
In this section we use the  application. 
 

A1.1 Univariate data 
A1.1.1 Working with ungrouped univariate data 
The height of twenty Year 11 students from across Australia was recorded. The results, in 
centimeters, are given below. 

185, 176, 184, 175, 173, 183, 182, 184, 174, 174, 
169, 179, 190, 175, 178, 203, 145, 188, 177, 162. 

 
Calculate the five number summary (min, Q1, median, Q3, max.) for the sample and make a 
histogram. 
 

Enter data into list1 (or an 
empty list). 
 
Select Calc, then  
One-Variable. 

 

        

Select the list1 as the XList 
using the drop down menu. Tap 
OK. 
 
The Stat Calculation 
screen will appear containing a 
basic statistical summary of the 
selected listed data. 
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To draw a histogram of the data 
tap SetGraph then choose 
Setting .... 
 
Set up Statgraph 1. 
Set Draw to On. 
Type to Histogram. 
Xlist to list1 
Freq to 1. 
 
Tap Set. 
 
Tap y to draw the histogram. 
 
         

A1.1.2 Working with grouped univariate data 
The following table shows the number of “Smarties” in each of 50 packets. 
 

# of Smarties Frequency 
40 1 
41 8 
42 29 
43 7 
44 4 
45 1 

 
a. Calculate the mean, median and mode. 
b. Find the total number of Smarties in 50 packets. 

 
Enter data into list1 and 
frequency into list2 (or other 
empty lists). 
 
Select Calc, then  
One-  
Variable.  

        

Select list1 for the XList 
and list2 for the Freq using 
the drop down menu. Tap OK.  
 
The Stat Calculation 
screen will appear containing a 
basic statistical summary of the 
selected listed data. 
 
Note: You can rename the lists; 
however, do so before entering your 
data. Once named, the list is considered 
to be a variable. 
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A1.1.3 Histogram 
The frequency table shows the length (l) of 80 fish caught in a fishing competition. 
 

Length (mm) Frequency 
295 ≤  l <305 8 

305 ≤  l <315 17 

315 ≤  l <325 19 

325 ≤  l <335 13 

335 ≤  l <345 10 

345 ≤  l <355 6 

355 ≤  l <365 4 

365 ≤  l <375 3 
Draw a histogram. 
 
Enter the midpoints of each class 
into list1, frequency into 
list2. 
 
Tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.) 
 
Adjust the Set StatGraphs 
options. Press Set. 
 

        

Tap y on the tool bar to make 
the graph. 
 
The Set Interval box will 
appear – set HStart to 300 and 
HStep to 10 (this is critical). Press 
OK. 
 
The histogram will appear in the 
StatGraph window. (Press 
Analysis, then Trace, to 
display the XList and Freq on 
the histogram.) 
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A1.1.4 Box plot 
The height of twenty Year 11 students from across Australia has been recorded. The results, in 
centimeters, are given below. 

185, 176, 184, 175, 173, 183, 182, 184, 174, 174, 
169, 179, 190, 175, 178, 203, 145, 188, 177, 162. 

 
1) Construct a box plot with this data. 
2) Hence, state the five figure summary (min, Q1, median, Q3, max) for the sample. 

 

Enter data into list1 (or an 
empty list). 
 

Tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.) 
 
Adjust the Set StatGraphs 
options. Type: MedBox.  
Make sure you do not tick the 
Show Outliers box.  
Tap Set.         

Tap y on the tool bar to 
sketch the boxplot. 
 
The box plot will appear in the 
StatGraph window. 
 
Tap Analysis, then Trace. 
Use the cursor key or graph 
controller arrows (left/right) to 
jump between values. 
 

        

Box plot with outliers 
(Modified box plot) 
- utilises the IQR×5.1  rule, 
which defines limits for 
“outliers”. 
 
Set up StatGraph 2 as a modified 
boxplot. 
To make a modified box plot, 
tick the Show Outliers box. 
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A1.2 Cumulative frequency curves (or ogives) 
The frequency table shows the length (l) of 80 fish caught in a fishing competition. 
 

Length (mm) Frequency 
295 ≤  l <305 8 

305 ≤  l <315 17 

315 ≤  l <325 19 

325 ≤  l <335 13 

335 ≤  l <345 10 

345 ≤  l <355 6 

355 ≤  l <365 4 

365 ≤  l <375 3 
a. Add a cumulative frequency column to the table. 
b. Represent the data using cumulative frequency curve. 

 

Enter the midpoints of each class 
into list1, frequency into 
list2. 
 
Use the formula cuml(list2) to 
calculate the cumulative 
frequency values in list3. Type 
this formula into the Cal cell at 
the bottom of list3. 
 
Tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.) 
 
Adjust the Set StatGraphs 
options. Press Set. 
 

        

Tap y on the tool bar to 
sketch the curve. 
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A1.4 Bivariate data 
This section will use the following example to demonstrate bivariate data analysis with the ClassPad. 
 
Swimming Pool Attendance and Daily Maximum Temperature 
The operators of a local swimming pool record the following data: 
 

Day 
Max. temp 
C°  Attendance 

1 18 870 
2 17 819 
3 30 2168 
4 16 714 
5 20 1435 
6 22 1458 
7 16 819 
8 12 406 
9 14 231 
10 15 572 
11 16 603 
12 17 839 
13 15 572 
14 15 806 
15 18 1218 
16 19 1007 
17 23 931 
18 21 1215 
19 19 995 
20 21 275 
21 25 1894 
22 29 2301 
23 26 2207 
24 24 2109 
25 30 2564 

 
a) Calculate the summary statistics for the two variables. 
b) Construct a scatter plot to examine the relationship between attendance and temperature. 
c) Calculate Pearson’s product–moment correlation coefficient, r. 
d) Calculate the coefficient of determination, r2.  
e) Calculate the equation of the least squares line. 
f) Sketch the least squares line. 
g) Make a table of residuals and a residual plot. 
h) Use your equation to predict the attendance on a day of maximum temperature at C°23  and 

compare your result to Day 17. 
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Task: 
a) Calculate the summary 
statistics for the two variables. 
 
Enter temperature into list1 
and attendance into list2. 
Remember to rename the lists 
first! 
 
Select Calc then Two-
Variable. 
 

        

Select main\temp for the 
XList and main\attend for 
the YList using the drop down 
menu. Tap OK. 
 
The Stat Calculation 
screen will appear containing 
summary statistics of the selected 
two variable data. Scroll down to 
see the y variable statistics 
         

A1.4.1 Scatter plot 
b) Construct a scatter plot to 
examine the relationship between 
temperature and attendance. 
 
Tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.) 
 
Adjust the Set StatGraphs 
options. Press Set. 
 
Tap y on the tool bar to 
sketch the curve. 
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A1.4.2 Correlation coefficient, r and coefficient of determination, r 2 
c) Calculate Pearson’s product–moment correlation coefficient, r. 
 
d) Calculate the coefficient of determination, r 2.  
 
These tasks can be performed simultaneously, while also calculating the residuals. 
 

With the List Editor window 
active, select Calc from the 
menu bar, Regression, 
followed by Linear Reg. 
 
Adjust the Set 
Calculation options. (Be 
sure to 

a) change the Copy 
Formula setting to y1 
and 

b) Copy Residual 
setting to list3.) 

Tap OK. 
 
         

The Stat Calculation 
screen will appear containing, 
correlation coefficient, r, and the 
coefficient of determination, r2. 
(MSe is the mean square error. 
 
Note: Once the Set 
Calculation window is 
closed by tapping OK, the least 
squares line will automatically be 
sketched in a Statgraph window.  
 
Also, the residuals will appear in 
list 3 in the List Editor window. 
 

        

 
 

144 



A1.4.3 Calculating the Least-squares line 
e) Calculate the least squares 
regression line. 
 
The ouput screen from the 
previous section also includes the 
slope and intercept.  
 
Note: Once the Set 
Calculation window is 
closed by tapping OK, the least 
squares line will automatically be 
sketched in a Statgraph window.  
 
 

        

A1.4.4 Sketch Least-squares line 
f) Sketch the least squares line. 
An alternative to the method 
seen above is: 
 
To sketch the least squares line 
tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.) 
 
Adjust the Set StatGraphs 
options. Leave StatGraph 1 as is 
and set up StatGraph 2 as shown. 
Tap Set.  
 
Tap y on the tool bar. 
 

        

A1.4.5 Making a residual plot 
g) Make a table of residuals and a 
residual plot. 
 
In part e) you will have calculated 
the residuals and placed then in 
list3. 
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To produce a residual plot, 
 tap G on the tool bar. (Or, 
select SetGraph from the 
menu bar, then Setting.)  
Choose StatGraph3. 
 
Adjust the Set StatGraphs 
options.  
 
Untick the Draw option for 
StatGraph 1 & 2. 
 
Set StatGraph 3 to be as shown, 
be sure to select the residual list 
(list3) for the YList.  
 
Tap Set.         

Tap y on the tool bar.  

  

A1.4.6 Using the Least-squares line 
h) Use your equation to predict the attendance on a day of maximum temperature at C°23  and 
compare your result to Day 17. 
 

There are many different ways to 
achieve this – here is one 
method: 
 
With the List Editor window 
active, select Calc from the 
menu bar, Regression, 
followed by Linear Reg. 
 
Adjust the Set 
Calculation options. (Be 
sure to change the Copy 
Formula setting to y1 and 
Copy Residual setting to 
list3.)  Tap OK. 
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Tap M on the icon panel.  
 
Key in y1(23). Press E. 
 
Solve the equation  
y1(x)=27. 
 
 

 

A1.4.7 Logarithmic transformation of data 
Consider the following data stored as the variables ‘time’ and 
‘list2’ respectively. 
 
The graph of list2 vs time suggests the possibility that the 
variation may be described by an exponential function. 
 

 
 

To transform, in the third column define a new variable 
‘loglist2’ – any name can be used or simply use list3. 
 
Tap in the Calculation cell at the bottom of this list. 
 
Now type in the calculation you desire. Note that the full 
calculation is seen in the edit bar . Tap E. 
 
Make a graph of the log(list2) vs time. 
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Appendix 2 – Numerical Solver Application 
 
This section assumes that the ClassPad is operating the 

 application. 
 
Note: While this application can be launched from the Menu it 
can also be from the Graph Editor, 3D Graph Editor and the 
Main application. Simply tap O when in these applications. 
 
Equations/formulae can be ‘dragged and dropped’ from the 
above mentioned applications into the Numeric Solver window. 
 

 
 

A2.1 Using the numeric solver 

The volume of a cone, radius r cm and height h cm, is given by: 
3

2hrV π
= . 

a) Find the volume of a cone with r = 12 cm and h = 7 cm. 
b) Find the radius of a cone if h = 10 cm and V = 1500 cm3. 

 

Tap in the equation:  
(Use the soft keyboards to enter 
the equation using natural input).  
Tap E. 
 
The list of expression’s variables 
will appear. Enter the values. 
 
Enter the values of the variables 
you know and select the variable 
you want to find by checking the 
adjacent button. 
Tap 1 on the tool bar. 

        

  

Note that the Left-Right = 0 refers to the value of the right hand side of the equation subtracted 
from the left hand side of the equation of the value of the variable computed. If this is 0, then 
we confident the correct value of the variable has been computed. 
 

The lower and upper bounds for 
the solution can also be specified. 
If the solution is not within the 
specified range, an error will 
occur – see opposite. 
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Index 
Absolute value, 55 
Action, 22 
Active windows, 35 
Add-in applications, 129 
Algy 2, 125 
Amortization, 108 
Angles, 24 
Animate, 118, 122 
Application menu, 13 
Area between two curves, 82 
Area bound by a curve, 80 
Argument, 109 
Arithmetic, 93 
Attached angle, 123 
Average rates of change, 72 
 
Backing up, 128 
Basic format, 31 
Binomial distribution, 97 
Bivariate data, 142 
Box plot, 140 
Box plot with outliers, 140 
Box zoom, 46 
 
Calculation (geometry), 123 
Cartesian form, 110 
Cartesian plane, 111 
Cas, 133 
Catalogue, 28, 29, 30, 71 
Circles, 115 
Clear all variables, 20, 22 
Clear_a_z, 22 
Coefficient of determination, 144 
Complex numbers, 109 
Composite functions, 56 
Compound interest, 107 
Conics, 115 
Conjugate, 109 
Constraints, 120 
Continuous probability distributions, 101 
Continuous random variable, 101, 106 
Correlation coefficient, 144 
Cross product, 113 
Cumulative frequency curve, 141 
Cumulative normal distribution, 102 
Current working folder, 21 
 
Data transfer, 131 
Default K key assignments, 36 
Define a sequence, 92 
Define a variable, 20 
Defining, 20 
Defining a function, 24 

Defining a list, 21 
Definite integral, 79 
Definite integral, 78, 80 
Degrees, 24 
Degrees to radians, 26 
Degrees, minutes and seconds, 25 
Delete a variable, 22 
Delvar, 22 
Derivative at a point, 73 
Derivative function, 75 
Derivatives, 73 
Determinant, 89 
Difference equations, 94 
Differential equations, 85 
Direction/slope field, 85 
Discrete random variables, 95 
Display measurements, 122 
Distance between two points, 44 
DMS key, 25, 26 
Domain, 52 
Drawing, 118, 121 
 
Ellipses, 115 
Enter functions, 48 
Entering functions, 38 
Equating probabilities, 106 
Equation, 34 
Euler’s method, 86 
Exact form, 133 
Expand, 32 
Expected value, 97 
 
Factorise, 32 
Financial calculations, 107 
Find x-value given a y-value, 43 
Find y-value given a x-value, 43 
Formulae, 148 
Function, 24, 38 
Functions in terms of other functions, 50 
 
Geometric transformations, 90 
Geometry, 118 
Graph, 37 
Graph & table application, 37 
Graph controller arrows, 47 
Graph format, 38 
Graph line style, 50 
Graph style settings, 50 
G-Solve, 40 
 
Histogram, 139 
Hybrid function, 53 
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Imaginary part, 109 
Indefinite integrals, 77 
Inequality, 49 
Inflection, 42 
Initialize, 46 
Instantaneous rates of change, 72 
Insufficient memory, 136 
Integration, 77 
Interactive, 16, 18, 51, 71, 73, 77, 78, 84, 89, 

93, 109, 110 
Interactive menu, 16 
Intersection, 134 
Intersection point, 44 
Inverse function, 51 
Inverse matrix, 89 
Inverse normal distribution, 103 
 
Judge, 17 
 
Least squares line, 145 
Least squares regression line, 145 
Least squares regression line, 62 
Limits, 71 
Logarithmic transformation, 65, 147 
Logarithms, 18 
 
Main application, 14, 51, 93, 115, 148 
Managing your classpad, 126 
Markov chains, 90 
Matrices, 87 
Matrix, 87 
Matrix calculations, 87 
Maximum point/s, 41 
Mean, 95 
Mean value of a function, 83 
Measuring, 119 
Memory, 127 
Menus, 35 
Minimum point/s, 42 
Mixed function, 53 
Mode indicators, 15 
Modified box plot, 140 
Modulus, 55 
Moving average smoothing, 70 
Moving objects, 120 
Multiplication signs, 19 
 
Normal, 77 
Normal distribution, 102 
Normal to a curve, 76 
Numeric solver, 148 
Numerical iteration, 133 
 
 
 

Ogives, 141 
Operating system, 126 
Outliers, 140 
 
Panning the graph view window, 47 
Parameters, 48 
Parametric curve, 114 
Partial fraction, 33 
Pictures, 130 
Piecewise function, 53 
Plot, 38 
Plot a sequence, 92 
Plot functions, 38 
Polar form, 110 
Population parameters, 104 
Prime factors, 18 
Probability distributions, 95 
Product functions, 56 
Pythagoras’ theorem, 20 
 
Quick zoom commands, 47 
 
r, 144 
r2, 144 
Radians to degrees, 26 
Random number generation, 28 
Random numbers, 28 
Rates of change, 72 
Rational functions, 54 
Real part, 109 
Reciprocal functions, 53 
Regions in the complex plane, 109, 110 
Relation, 115 
Residual plot, 145 
Restrict domain of a function, 52 
 
Scatter plot, 63, 66 
Scatter plot, 143 
Screen receiver, 127 
Scrolling, 47 
Second derivative, 83 
Sequence, arithmetic, 93 
Sequences, 91 
Shift key assign, 36 
Sign of the derivative, 75 
Simultaneous equations, 90 
Simultaneous equations, 34 
Sketch bounded region, 49 
Sketch complex plane, 110 
Sketch probability region, 102 
Slope/direction field, 85 
Soft keyboard, 16 
Soft keyboard., 17, 18, 19, 20 
Solve, 34, 35, 136 
Solve numerically, 136 
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Solver, 148 
Solving equations, 133 
Spinning wheel, 135 
Spreadsheet application, 58 
Standard deviation, 95 
Stationary points, 41 
Statistical calculations, 137 
Statistical calculations using spreadsheet, 58 
Status bar mode indicators, 15 
Storage memory, 127 
Stored variables, 21 
Stylus, 12 
Sum and difference functions, 54 
Summary statistics, 59, 143 
Summary statistics in the spreadsheet 

application, 59 
Summing of a sequence, 93 
Symbolic calculations, 31 
Syntax, 73, 126 
System application, 11 
 
Table input, 37 
Table of values, 37 
Tabulate a sequence, 92 
Tangent to a curve, 76 
Three-median smoothing, 67 
Tool bars, 35 
Touch panel alignment, 126 
Touch panel alignment.. See 
Trace, 39 
Transformations, 50 

Transition matrices, 90 
Trigonometric calculations, 26 
Trigonometric form, 109 
TVM, 107 
 
Unit vector, 113 
Univariate data, 138 
Univariate data, 137 
Update software, 126 
Updating classpad, 126 
USB flash, 127 
 
Variable manager, 21 
Variables, 19, 20, 21, 51, 143, 148 
Variance, 95 
Vector operations, 113 
Vectors, 111 
Vectors that are functions of time, 114 
View window. See 
View window parameters, 45 
Volumes of solids of revolution, 84 
 
Windows, 35 
 
x-Cal, 43 
 
y-Cal, 43 
 
Zoom, 46 
Zoom commands, 46 
Zooming, 46 
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